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Introduction générale  

Le processus de conception d’un nouveau médicament est très long, couteux et fastidieux, allant de 

l’identification d’une cible thérapeutique en passant par la recherche des composés actifs jusqu’aux 

essais cliniques. En moyenne, de 12 à 15 ans d’efforts et 1 milliard de dollar sont nécessaires pour la 

mise d’un nouveau médicament sur le marché [1][2].  

Pour surmonter ces défis, le docking moléculaire est un outil exemplaire. Il s’agit d’une approche, 

faisant partie de la modélisation moléculaire, permettant la simulation des interactions protéine-ligand 

le plus souvent. Le docking moléculaire est devenu de plus en plus utile lors des premières phases de 

drug design en raison de l'immense croissance des structures 3D de rayons X et de RMN et de leurs 

résolutions améliorées rapportées dans la banque de données des protéines (PDB) [2][3].  

Dans ce travail, nous avons utilisé le programme de docking moléculaire AutoDock [4] pour étudier 

les mécanismes d'inhibition de la Kynurénine 3-monooxygénase (KMO). Cette enzyme est 

responsable de la conversion de la kynurénine (KYN) en 3-hydroxykynurénine (3-HK) faisant partie 

de la voie de la kynurénine ; principale voie du métabolisme du tryptophane chez les mammifères 

[5][6]. La KMO est considérée comme la meilleure cible thérapeutique dans cette voie car son blocage 

fait augmenter le neuroprotecteur l’acide kynurénique (KA) et diminuer les métabolites 

neurotoxiques, 3-HK, Acide 3-hydroxyanthranilique (3OHAA) et l’acide quinolinique (QA) [7].  Il a 

été démontré dans de nombreuses études que les inhibiteurs de KMO peuvent être utiles dans le 

traitement de divers maladies et troubles neurologiques telles que : la maladie de Huntington 

[8][9][10], la maladie d'Alzheimer [11], la maladie de Parkinson [5][12], ainsi que d’autres maladies 

comme : la pancréatite aiguë [13][14][15][16]. A ce jour-là, il n’existe aucun médicament sur le 

marché ciblant cette enzyme. 

L’objectif du présent travail est de contribuer au développement de nouveaux inhibiteurs de cette 

enzyme, ainsi, d’évaluer la performance du programme de docking AutoDock utilisé dans cette étude. 

Au préalable, nous avons évalué la fiabilité de logiciel utilisé, AutoDock, en appliquant trois tests. Le 

premier test consiste à calculer l’écart quadratique moyen ou RMSD en angströms entre la pose du 

ligand conçue par le logiciel et celle de référence déterminée expérimentalement. Ce test a été conforté 

par une analyse visuelle permettant de visualiser la superposition des modèles de ligands théoriques 

et expérimentaux. Le dernier test consiste à évaluer le degré de corrélation existant entre les énergies 

d’interaction calculées par AutoDock et les valeurs expérimentales des IC50 des inhibiteurs de la KMO 

étudiés. 
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Ensuite, une étude approfondie du mode d’inhibition de la PfKMO par plusieurs inhibiteurs 

provenant de la littérature a été menée. L’évaluation de leurs énergies d’interaction à l’égard de la 

PfKMO par docking moléculaire nous a permet de déterminer l’inhibiteur le plus puissant de cette 

enzyme. Ce composé a été utilisé, par la suite, comme structure de départ pour la conception in silico 

de nouveaux inhibiteurs encore plus puissants de la KMO tout en améliorant sa pénétration à travers 

la barrière hémato-encéphalique. Dans cette optique, un criblage virtuel d’une collection de similaires 

chimiques du composé de départ a été, dans un premier temps menée, suivie par une série de 

substitutions structurales pour aboutir à la fin à la proposition d’un nouveau inhibiteur potentiellement 

plus actif.  

Enfin, une dernière étude prédictive des propriétés physicochimiques, pharmacocinétiques et de 

toxicité potentielle des composés nouvellement proposés a été menée en vue de vérifier leurs 

paramètres ADMET. 

Ce manuscrit englobe quatre (4) chapitres : 

• Le premier chapitre : traite l’enzyme cible (KMO) et ses inhibiteurs. 

• Le deuxième chapitre : décrit le docking moléculaire et les outils nécessaires à son application. 

• Le troisième chapitre : regroupe tout le matériel et les méthodes utilisés dans ce travail. 

• Le quatrième chapitre : expose l’essentiel des résultats obtenus avec une discussion. 

• Une conclusion et quelques perspectives clôtureront ce mémoire. 



 

 

 

 

 

 

 

 

 

Chapitre 1 : LA KYNURÉNINE 3-

MONOOXYGENASE 
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1. Le métabolisme du tryptophane via la voie des kynurénines 

Le tryptophane (TRP) est un acide aminé indispensable qui ne peut pas être synthétisé dans 

l’organisme. Il doit donc être apporté par l’alimentation. Un apport journalier en tryptophane de 

4mg/kg/jour est recommandé par l’OMS. Les sources de tryptophane dans l’alimentation sont 

majoritairement : les œufs, le lait et les produits laitiers, et les produits carnés. Ces concentrations 

moyennes dans le sang sont comprises entre 50 et 60 μmol/L. Le tryptophane (figure N°1) est utilisé 

pour la synthèse protéique et il est également le substrat de deux voies métaboliques indispensables 

dans l’organisme : la voie de synthèse de la sérotonine et la voie des kynurénines (KP) [17].  

 

Figure 1 : La structure du tryptophane. 

La voie des kynurénines est la principale voie de métabolisation du tryptophane chez les 

mammifères. En effet, plus de 95% du tryptophane est métabolisé et converti via la voie des 

kynurénines en kynurénine (KYN) et ses produits de dégradation dans les tissus périphériques (comme 

le foie et les reins) et le système nerveux central (e.g. les astrocytes, les microglies). Dans une étude 

sur les neurospora en 1947, Beadle et al. ont découvert que cette voie aboutisse à la génération d’une 

importante source d'énergie cellulaire, la nicotinamide adénine dinucléotide (NAD+) [6][7][18][19]. 

La voie des kynurénines joue un rôle important dans de nombreuses maladies et troubles, du cancer 

aux maladies infectieuses, telles que le VIH, les troubles neurologiques (la schizophrénie et la 

dépression), les maladies auto-immunes (la sclérose en plaques et la polyarthrite rhumatoïde), des 

affections périphériques (les maladies cardiovasculaires et la pancréatite aiguë), les maladies 

neurodégénératives (la maladie de Huntington, la maladie d'Alzheimer et la maladie de 

Parkinson)[6][20][21].  

La première étape du métabolisme du tryptophane en kynurénines est une oxygénation du TRP. 

Comme le montre la figure N°2, cette étape est catalysée par l'une des deux enzymes : l’enzyme 

tryptophane 2,3 dioxygénase (TDO) et l’enzyme indoléamine 2,3-dioxygénase (IDO). La TDO est un 
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analogue de l’enzyme IDO, c'est-à-dire que leur fonction est identique (même activité catalytique) 

mais leur origine est indépendante. Ces enzymes catalysent la formation du métabolite N-

formylkynurénine (NFK). La TDO a été trouvée dans le cerveau en faible quantité mais cette enzyme 

est principalement exprimée dans le foie. L’expression de TDO est augmentée par les glucocorticoïdes 

(cortisol) et le tryptophane lui-même, ce qui fait de cette enzyme le régulateur des concentrations 

plasmatiques en tryptophane. En revanche, l’IDO est ubiquitaire dans l'organisme, elle est 

principalement extra-hépatique et exprimée majoritairement dans le cerveau, dans le tractus digestif, 

les poumons et également le placenta ainsi que les cellules immunitaires, l’expression et l’activité de 

la IDO sont augmentées par les cytokines inflammatoires telles que L’IFNγ et inhibées par la molécule 

1-méthyltryptophane. Le métabolite NFK est ensuite métabolisé par une formamidase très rapidement 

en kynurénine (KYN), le premier métabolite stable de la voie [6][17][22].  

KYN peut agir comme substrat pour trois enzymes et donc elle a trois voies métaboliques catalysées 

par kynurénine aminotransférases (KATs), kynureninase (KYNU), et kynurénine 3-monooxygenase 

(KMO). 

 

Figure 2 : La voie des kynurénines et ses voies en aval de la sérotonine, glycolyse et NAD+. 

IDO: Indoléamine 2,3-dioxygénase, TDO: Tryptophane-2,3-dioxygénase, AFMID: Kynurénine 

formamidase, KATs: Kynurénine aminotransférases, KMO: Kynurénine 3‐monooxygenase, 

KYNU: Kynureninase, A3M: Anthranilate 3‐monooxygenase, HAAO: 3-Hydroxyanthranilate 3,4 

dioxygénase, ACMSD: 2-amino-3-carboxymuconate-6-semialdehyde décarboxylase, QPRT: 

Quinolinate phosphoryltransférase. [22][23][24] 
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Les enzymes KATs catalysent la transamination irréversible de KYN en acide kynurénique (KA). 

L’activité de KATs dépend de la présence du co-enzyme vitamine B6. KYN peut également réagir 

avec KYNU en formant de l'acide anthranilique. Cependant, KYN a une affinité plus élevée pour 

KMO que KATs et KYNU. L’enzyme KMO métabolise KYN en 3-hydroxykynurénine (3-HK) qui 

est ensuite métabolisé en acide 3-hydroxyanthranilique (3OHAA) par l’enzyme KYNU. L’acide 3-

hydroxyanthranilique est aussi obtenue par la métabolisation d’acide Anthranilique par l’enzyme 

anthranilate 3‐monooxygenase (A3M). L’activité enzymatique de KYNU est dépendante du cofacteur 

pyridoxal 5-phosphate (PLP), la vitamine B6 et l’expression de cette enzyme est également induite 

par des cytokines pro-inflammatoires [17][25][26].  

Le 3OHAA est métabolisé par l’enzyme 3-hydroxyanthranilate 3,4 dioxygénase (HAAO) en 2-

amino-3-carboxymuconate 6-semialdéhyde (ACMS). Ce dernier peut se diriger vers la synthèse de 

deux acides ; d’une part, l’enzyme 2-amino 3-carboxymuconate 6-semialdehyde décarboxylase 

(ACMSD) qui est exprimée dans le cerveau, le foie et les reins chez l’homme, métabolise l’ACMS en 

2-aminomuconate 6-semialdéhyde et par la suite en acide picolinique (PA) ; d’autre part, l’ACMS 

subit une cyclisation spontanée et non enzymatique en l’acide quinolinique (QA). L’enzyme qui 

intervient à ce niveau est la quinolinate phosphoryltransférase (QPRT) en catalysant la première étape 

de la synthèse de novo de NAD+ à partir de QA [17][18].  

Il est important de noter qu'il existe plusieurs intermédiaires neuroactifs dans cette voie: KA, QA, 

et 3-HK dont nous parlerons plus en détail par la suite [18].  

 

2. Nomenclature et Classification de la Kynurénine 3-monooxygenase 

La KMO (EC 1.14.13.9) aussi connue par Kynurénine 3-hydroxylase fonctionne à un point clé de 

la voie des kynurénines. Cette enzyme faisant l'objet de cette étude appartient aux oxydoréductases 

qui agissent sur les donneurs appariés avec incorporation de molécule de dioxygène (les 

dioxygénases)[5].  

La KMO est caractérisée comme une flavoprotéine hydroxylase aromatique (FAHs) de classe A 

catalysant une réaction de monooxygénation en validant les critères suivants: elle est codée par un 

seul gène, possède une coenzyme FAD lié de manière non covalente, utilise le NADPH, puis libère le 

NADP+ après réduction de FAD et possède un seul domaine de liaison aux dinucléotides de pli 

Rossmann [6][27].  
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3. Description structurale de la Kynurénine 3-monooxygenase 

La KMO humaine (hKMO) contient 486 acides aminés ce qui correspond à un poids moléculaire 

d'environ 5 kDa. C’est un dimère contenant des sous-unités asymétriques. Elle présente une hélice 

transmembranaire C-terminale d'environ 50 résidus de long [6].  

 

Figure 3 : Structure cristalline du la Kynurénine 3-monooxygenase humaine en présence de 

cofacteur FAD (code PDB : 5X68). [28] 

Des études sur la distribution tissulaire ont montré que la KMO des mammifères se situe dans la 

membrane externe de la mitochondrie. La KMO humaine est fortement exprimée dans le foie et les 

reins, mais également dans la microglie et les macrophages infiltrants dans le cerveau. Bien qu'elle 

soit exprimée d’une manière ubiquitaire, de très faibles niveaux de la KMO ont été trouvés dans les 

cellules du cerveau. L'extrémité C-terminale du KMO jouant un rôle important dans l'activité 

enzymatique se lie à la membrane mitochondriale externe et est donc très hydrophobe. Cela réduit 

considérablement la stabilité du KMO exprimée de manière recombinante et, par conséquent, 

l'obtention du KMO humaine ou des autres mammifères a été difficile. Les premières tentatives ne 

produisant que des purifications partielles de l'enzyme inactive. En raison de ces problèmes, des KMO 

d'autres organismes ont été utilisées pour étudier son mécanisme et sa structure. Il faut noter qu’il 

existe un niveau élevé de conservation entre les KMO de différentes espèces, notamment au niveau 

de leur site actif [6][7][20][29].  

La KMO de Saccharomyces cerevisiae (ScKMO) a été exprimée avec succès par recombinaison 

dans Escherichia coli et sa purification a abouti à l'isolement du ScKMO. Cette KMO a montré dans 

un essai basé sur HPLC sa capacité à convertir la kynurénine (KYN) en 3-hydroxykynurénine (3-HK) 
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même s'elle n'a pas de domaine C-terminal. La ScKMO a été cristallisée avec succès à la fois sans 

substrat et en complexe avec un inhibiteur UPF 648 et cela a conduit à la publication de la première 

structure de KMO sous le code PDB : 4J36. Les ScKMO et hKMO partagent 38% d'identité et 51% 

de similarité et tous les résidus impliqués dans la liaison des ligands sont conservés entre les deux 

espèces. La structure de ScKMO a été un modèle utile au développement de nouveaux échafaudages 

inhibiteurs[6][7][20][30].  

 

Figure 4 : Comparaison structurelle de hKMO et ScKMO.  

Superposition des structures cristallines du hKMO en gris et du ScKMO en rouge. L’hélice α de 

l’extrémité C-terminale est représenté par un cylindre. [28] 

De nombreux travaux ont été menés sur la KMO de Pseudomonas fluorescens (PfKMO). Le 

principal avantage de PfKMO est qu'étant procaryote, elle n'est pas lié à la membrane. Le domaine C-

terminal est donc beaucoup moins hydrophobe et la protéine est globalement plus stable [7].  

 

Figure 5 : Structure de PfKMO lié avec KYN (code PDB : 5NAK). [6] 

La KYN en sphères, le FAD en bâtons sont liés à la chaîne A (verte), tandis que la chaîne B (cyan) a 

seulement lié avec le FAD en bâtons. Le domaine C-terminal est représenté en magenta pour la 

chaîne A et en bleu pour la chaîne B. 
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La PfKMO est une enzyme soluble avec 36% d’identité et 54% d'homologie avec hKMO qui peut 

être exprimée de façon hétérologue dans Escherichia coli. Les structures cristallines de PfKMO liés à 

la kynurénine (figure N°5) et avec des différents inhibiteurs ont été récemment résolues. Tous les 

résidus PfKMO qui entourent le site catalytique sont conservés par rapport au hKMO, à l'exception 

du His320, qui est remplacé par une phénylalanine dans la protéine humaine [13][30].  

La PfKMO contient deux domaines, le domaine principal contenant le pli de Rossmann, le site actif, 

le cofacteur FAD et un domaine C-terminal. Les résidus hydrophiles : Arg84, Tyr98, Tyr404 et 

Asn369 sont proches des groupes carboxylates du substrat et les résidus hydrophobes : Leu213, 

Leu226, Ile224, Phe238 et Met373 sont proches de l'anneau aromatique du substrat. Lorsque la 

kynurénine est dans le site actif, les interactions entre le groupe carboxylate et Arg84, Tyr98, Tyr404 

et Asn369 sont présentes, révélant des interactions clés entre PfKMO et les substrats [6][7].  

 

Figure 6 : Structure cristalline du site actif de PfKMO lié à KYN. [7] 

Suite à la liaison d’un substrat, un changement conformationnel significatif a été observé dans la 

position du domaine C-terminal. Pour cette raison, il a été conclu que le domaine C-terminal joue un 

rôle intégral dans la liaison des substrats. Lorsque PfKMO ne se lie pas à un substrat ou à un inhibiteur, 

l'enzyme est censée être dans une conformation «ouverte». Une fois qu'un substrat se lie à PfKMO, le 

domaine C-terminal se déplace alors pour donner une conformation «fermée», observée dans la 

structure avec de la kynurénine ou des inhibiteurs liés [6][7].  
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Figure 7 : Surfaces de structures cristallines de PfKMO.  

A gauche, la position fermée liée au substrat ; A droite, la position ouverte sans substrat, avec un 

canal menant au FAD. Le domaine C-terminal est représenté en une couleur plus claire. [7] 

 

4. Fonction et Mécanisme d’action de la Kynurénine 3-monooxygenase  

En 1956, la KMO a été découverte pour la première fois comme responsable de la conversion du 

KYN en 3-HK dans les mitochondries du foie des chats et des rats [31].  

 

Figure 8 : Métabolisation de KYN en 3-HK. 

Le mécanisme de réaction proposé pour KMO a été développé après avoir étudié la PfKMO. Le 

cycle catalytique de KMO peut être divisé en deux demi-réactions, une moitié réductrice et une moitié 

oxydante. La liaison de KYN au KMO est relativement lente, ce qui rend la réduction de moitié de 

cette réaction dépendante de KYN. Une fois que la KYN et le NADPH se lient au KMO, le cofacteur 

FAD est réduit par le NADPH, et le NADP + est libéré par l'enzyme. Le complexe enzymatique réagit 

ensuite avec l'oxygène moléculaire, formant un intermédiaire 4a-peroxyflavine qui transfère un atome 

d’oxygène au substrat. La 4a-hydroxyflavine résultante est rapidement déshydratée avant la libération 

du produit. Le complexe enzymatique oxydé subit ensuite un changement conformationnel, facilitant 

la libération du produit 3-HK, dans l'étape de limitation de vitesse de ce mécanisme [5][6][20][32].  
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Figure 9 : Le mécanisme catalytique proposé du KMO de Pseudomonas fluorescens. [6] 

 

5. Effets thérapeutiques de l’inhibition de la Kynurénine 3-monooxygenase 

La kynurénine (KYN) est considérée comme le point de ramification de la voie des kynurénines. 

Elle a le potentiel d'être convertie en trois métabolites neuroactifs précédemment cités : KA, QA, et 

3-HK. 

L’acide kynurénique (KA), formé principalement par transamination irréversible du KYN, est un 

neuro-inhibiteur possédant des propriétés neuroprotectrices et anticonvulsivantes. À des 

concentrations micro-molaires élevées, la KA antagonise largement les récepteurs ionotropes du 

glutamate. Cependant, il inhibe de manière préférentielle et compétitive le site co-agoniste de la 

glycine du récepteur N-méthyl D-aspartate (NMDA) à des concentrations plus faibles. Il agit aussi 

comme un modulateur allostérique négatif au niveau du récepteur α7-nicotinique. Plus récemment, il 

a été démontré que la KA agit comme agoniste sur un récepteur orphelin couplé aux protéines G 

(GPR35), modulant ainsi la production d'AMPc et inhibant les canaux Ca2 + de type N des neurones 

sympathiques et des astrocytes, finalement conduisant à une suppression de plusieurs voies 

inflammatoires. Il régule également la réponse immunitaire par ses effets agonistes sur le récepteur 

arylhydrocarboné (AhR), un facteur de transcription impliqué dans le métabolisme des xénobiotiques. 

La signalisation AhR semble jouer un rôle important dans l'arrêt de la libération de cytokines dans 

plusieurs types de cellules, y compris les macrophages. De plus, KA peut agir comme antioxydant en 

piégeant les radicaux libres [18][26].  
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Figure 10 : La structure et les fonctions de l’acide kynurénique (KA). [33] 

L’acide quinolinique (QA) est une excitotoxine puissante, un agoniste des récepteurs NMDA qui 

peut en outre inhiber la recapture du glutamate par les astrocytes, conduisant à une excitotoxicité. Il 

exerce des effets neurotoxiques via plusieurs mécanismes différents, notamment la génération des 

radicaux libres hautement actifs, la perturbation de la barrière hémato-encéphalique, la déstabilisation 

du cytosquelette cellulaire, la promotion de la phosphorylation tau et la perturbation de l'autophagie. 

La QA potentialise également la réponse inflammatoire en induisant la production de médiateurs pro-

inflammatoires dans les astrocytes. La 3-hydroxykynurénine (3-HK) génère également des radicaux 

libres par auto-oxydation [6][18][25][26][34].  

 

Figure 11 : KA et QA dans le système nerveux et leurs effets sur NMDAr et α7nAChR. [7] 
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La Kynurénine 3-monooxygenase orchestre les événements majeurs de la voie des kynurénines. 

Elle est considérée comme la meilleure cible thérapeutique dans cette voie car le blocage à ce stade 

fait augmenter le neuroprotecteur KA et diminuer les métabolites neurotoxiques 3-HK, 3OHAA et 

QA [7].  

 

Figure 12 : Effet d’inhibition du KMO dans la voie des kynurénines.  

Les métabolites neuroactifs protecteurs et toxiques, en vert et en rouge respectivement. 

Comme l'inhibition du KMO est considérée comme une stratégie thérapeutique viable, il a été 

démontré dans de nombreuses études et recherches que les inhibiteurs de KMO peuvent être utiles 

dans le traitement de divers maladies et troubles neurologiques telles que : la maladie de Huntington 

[8][9][10], la maladie d'Alzheimer [11], la maladie de Parkinson [5][12], la sclérose latérale 

amyotrophique (SLA) [35], l’AVC ischémique [30], la schizophrénie [36][37], et les douleurs 

neuropathiques [38]; les maladies cardiovasculaires par exemple : la myocardite virale aiguë [39]; et 

d’autres maladies comme : la pancréatite aiguë [13][14][15][16], l’ischémie rénale [40], la carcinome 

hépatocellulaire (cancer du foie) [41], le cancer du sein [42], l’addiction de nicotine [43]. L'inhibition 

de KMO périphérique peut être une nouvelle mesure pour la prévention de l'obésité et du diabète [19].  
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6. Les inhibiteurs de la Kynurénine 3-monooxygenase  

6.1 Conception des inhibiteurs avant la structure cristalline du KMO  

Les premiers inhibiteurs de la KMO étaient basés sur des analogues de la kynurénine (KYN). Dans 

ce contexte, des travaux ont montré que la nicotinylalanine (IC50 = 900 μM) était un faible inhibiteur 

non spécifique de la KMO en provoquant in vivo une augmentation des niveaux d'acide kynurénique 

dans le tissu cérébral du rat [20].  

 

Figure 13 : La structure de la nicotinylalanine. 

6.1.1 Les acides 4-phenyl-4-oxobutanoiques  

Plusieurs inhibiteurs spécifiques ont montré des résultats prometteurs dans la régulation de 

l'homéostasie et de l'agonisme des récepteurs NMDA. Parmi ces composés, la m-nitrobenzyl alanine 

(m-NBA) était l'inhibiteur le plus puissant (IC50 = 0,9 μM) en augmentant les niveaux d'acide 

kynurénique et avait des propriétés anticonvulsivantes chez le rat. Inspiré par ces résultats, le m-NBA 

a été utilisé comme structure de départ pour la synthèse des inhibiteurs plus puissants. (R, S) -3,4-

dichlorobenzoylalanine (FCE 28833; IC50 de 0,2 μM) provoque une augmentation plus durable des 

niveaux d'acide kynurénique dans le tissu cérébral du rat [6][20].  

 

Figure 14 : La structure de m-NBA à droite et FCE 28833A à gauche. 

Bien que ces composés aient été parmi les premiers à inhiber la KMO, il a également été démontré 

plus tard qu'ils agissaient non seulement comme des inhibiteurs mais aussi comme des molécules 

effectrices. Il a été démontré que la 3,4-dichlorobenzoylalanine et la m-nitrobenzoylalanine se lient 
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dans le site actif du KMO et stimulent la réduction du NADPH entraînant la formation de 

l'hydroperoxyflavine instable qui est incapable d'hydroxyler ces molécules, entraînant la libération de 

H2O2 lorsque l'hydroperoxyflavine se décompose [20].  

6.1.2 Les sulfonamides 

Certains inhibiteurs de cette classe se sont révélés significativement plus puissants que la m-NBA 

et FCE 28833A, en particulier le Ro 61-8048 (IC50 = 37 nM). Il a été démontré que ce composé 

augmente les niveaux de KYN et de KA dans le cerveau grâce à l'inhibition périphérique du KMO, 

car il ne traverse pas la barrière hémato-encéphalique [5][6][20][44].  

 

Figure 15 : La structure de Ro 61-8048. 

6.1.3 Les acides 4-aryl-4-oxobutanoïques  

L'UPF-648 est le meilleur inhibiteur de la KMO appartenant à la famille des acides 4-aryl-4-

oxobutanoïques (IC50 = 20 nM). Il a été démontré que le traitement des souris par l’UPF-648 déplace 

la KP vers la synthèse de KA. Ce composé a ensuite été utilisé dans la première structure cristalline 

KMO à résoudre [6][25].  

 

Figure 16 : La structure de UPF-648. 

6.2 Conception des inhibiteurs après la structure cristalline du KMO  

Après la détermination de la structure KMO, il est devenu possible de concevoir des inhibiteurs 

KMO avec plus de précision. 
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6.2.1 Les acides arylpyrimidine carboxyliques  

La première classe d'inhibiteurs de la KMO conçue en utilisant les données structurales était les 

acides arylpyrimidine carboxyliques. Le CHDI-340246 (IC50 = 0,5 nM) s'est révélé être le meilleur 

composé. Il est hautement sélectif pour la KMO et a montré une puissance à la fois in vivo et in vitro. 

Lorsqu'il a été administré par voie orale sur des rats, une augmentation de la KYN et de la KA et une 

diminution à la fois de QA et de 3-HK dans le cerveau ont été observées [6][9][10][44].  

 

Figure 17 : La structure de CHDI-340246.  

6.2.2 Les oxazolidinones  

La GSK180 (IC50 = 6 nM) a été développé avec des propriétés physicochimiques appropriées pour 

l’administration intraveineuse. Le traitement par GSK180 a réduit le 3-HK et augmenté le KA dans 

les modèles de pancréatite aiguë chez le rat et la souris [44].  

 

Figure 18 : La structure de GSK180. 

6.2.3 Les benzisoxazoles  

Les benzisoxazoles sont les inhibiteurs de la KMO les plus puissants trouvés à ce jour. Ils ont été 

examinés pour leur puissance inhibitrice contre la KMO dans le but de cibler la pancréatite aiguë et 

le syndrome de dysfonctionnement d'organes multiples. Ils ont une structure similaire à la kynurénine. 

Le GSK 366 est de loin le plus puissant d'entre eux (IC50 = 0.7nM) [6].  
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Figure 19 : La structure de GSK366.  

Grâce aux techniques de similarité moléculaire, le diclofénac, un médicament anti-inflammatoire 

connu, a été identifié comme un inhibiteur de la KMO (IC50 = 13,6 μM) [6]. Cette étude ouvre la voie 

à de futures études utilisant des études de similitudes moléculaires ainsi que la réutilisation de 

médicaments.  

A ce jour-là, il n’existe aucun médicament sur le marché ciblant la Kynurénine 3-monooxygenase. 



 

 

 

 

 

 

 

 

 

Chapitre 2 : LE DOCKING 
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Le processus de développement d'un nouveau médicament, allant de l'identification d'une cible 

biologique d'intérêt thérapeutique jusqu'au patient, dans lequel les essais cliniques succèdent au 

développement pré-clinique dure environs 12 ans avec un coût global près d’un milliard de dollars. 

Dans le passé, L’approche traditionnelle de développement d'un nouveau médicament était basée sur 

le criblage à haut débit (High-Throughput Screening ou HTS). Cette approche consiste à tester in vitro 

l’activité biologique d’un très grand  nombre de ligand envers une cible thérapeutique d’intérêt, ce qui 

très coûteux et difficile à mettre en œuvre [1][45].  

Pour surmonter les inconvénients des approches traditionnelles, des méthodes plus efficaces ont été 

introduites pour la découverte de nouveaux médicaments reposant sur le criblage virtuel.  

Cette approche permettant de ne sélectionner qu’une partie de la base de données enrichie en 

molécules susceptibles d’interagir avec la cible protéique. Il permet la prédiction de l'activité des 

molécules in silico de manière rapide et à moindre cout [45][46].  

 

Figure 20 : Le processus de développement d’un médicament « Drug Design ». [47] 

 

1. Le criblage virtuel 

Le criblage virtuel st une approche théorique permettant de simuler l’activité biologique d’un très 

grand nombre de ligand pour ne sélectionner que les meilleurs. Cette approche est désormais 

largement utilisée lors des premières phases de conception d’un nouveau médicament. Le criblage 

virtuel peut être divisé en deux méthodes selon la disponibilité d'informations structurelles :  
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Le criblage virtuel basée sur la structure de la cible « Structure based » et le criblage virtuel basé sur 

la structure des  ligands « Ligand based » [46][48].  

• Les approches ligand-based sont souvent appliquées lorsque les informations structurelles sur 

la protéine cible sont rares et analysent les propriétés biologiques et chimiques d’une panoplie 

de ligands. Ils comprennent des pharmacophores à base de ligand, des modèles de relation 

quantitative structure-activité (QSAR) ainsi que des calculs de similitude basés sur les 

propriétés physicochimiques et les formes moléculaires [49].  

• Avec l'identification croissante des cibles biologiques et de leurs structures tridimensionnelles, 

les approches structure-based sont devenues plus populaires. Elles consistent à estimer la 

complémentarité structurale de chaque molécule criblée avec le site actif considéré [48][49].  

Bien que ces deux approches soient surtout utilisées de manière exclusive, leur combinaison lors 

du criblage permet de maximiser les chances de succès pour identifier de nouvelles touches 

"hits"[48][49].  

 

2. Le docking moléculaire 

Aussi connue par l'amarrage ou l’arrimage moléculaire, est une procédure in silico pour prédire la 

conformation d'un complexe récepteur-ligand, où la cible biologique d'intérêt thérapeutique 

(récepteur) est généralement une protéine ou une molécule d'acide nucléique (ADN ou ARN) et le 

principe actif (ligand) est soit une petite molécule soit une autre protéine. Le but de docking 

moléculaire est de classer les conformations résultant de l'association entre un ligand donné et une 

protéine cible d'une structure 3D connue grâce à des algorithmes, où les conformations protéine-ligand 

ou protéine-protéine sont obtenues in silico et comparées aux structures obtenues par cristallographie 

aux rayons X ou par résonance magnétique nucléaire (RMN) [1][48][50].  

Le docking moléculaire se déroule en deux étapes distinctes et complémentaires : 

• La première dite de « Docking », consiste à rechercher les conformations du ligand (génération 

de poses) capables à établir des interactions idéales avec le récepteur en utilisant des 

algorithmes de recherche tels que l'algorithme génétique et l’algorithme de Monte 

Carlo[48][51].  

• La deuxième dite de « Scoring », consiste à utiliser des méthodes mathématiques et des 

fonctions de score afin d’évaluer les poses obtenues lors de la première étape [48][51].  



 

                                                                                                                                       19 |   
 

  C H A P I T R E  2  :  L E  D O C K I N G  M O L É C U L A I R E  

 

 

Figure 21 : Les étapes typiques d'un docking moléculaire. [1] 

 

Figure 22 : Les deux étapes de docking moléculaire « Docking » et « Scoring ». [52] 

 

3. Les types du docking moléculaire 

Les différents types du docking se distinguent au niveau de leurs conditions d'application et de la 

nature des informations qu'elles peuvent fournir. La pertinence du choix d'un programme de docking 

donné repose en premier lieu sur l'adéquation entre ces caractéristiques et celles du système étudié. 

L'efficacité de l'algorithme choisi sera par ailleurs un compromis entre la rapidité d'exécution et la 

précision des résultats. Il existe trois type de docking [48] :  

• Le docking rigide : où la cible et le ligand sont considérés comme corps rigides. 

Historiquement, le docking rigide a été utilisé pour le développement des premiers logiciels. 

Ce docking est basé sur le principe dit : "lock-and-key" (principe clef-serrure), selon lequel le 
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ligand qui représente la clef, est complémentaire au niveau géométrique du site actif du 

récepteur, qui représente la serrure [48].  

• Le docking semi-flexible : où le ligand est considéré comme corps flexible. C'est le plus 

couramment utilisé car il permet d’obtenir des résultats plus précis [53][54].  

• Le docking flexible : où les deux molécules (ligand et cible) sont traitées en tant en compte 

leur flexibilité. Celui-ci a été développé suite à l'augmentation de la puissance de 

calcul[48][54].  

 

Figure 23 : Représentation du modèle clé-serrure pour le docking rigide. [55] 

 

4. Les outils du docking moléculaire 

Pour effectuer un docking moléculaire, il est nécessaire d’avoir un récepteur macromoléculaire de 

nature protéique, une petite molécule appelée ligand et un programme (logiciel) de docking [54].  

4.1 Le récepteur 

La majorité des structures protéiques sont disponibles via la Protein Data Bank (PDB). C’est la plus 

grande base de données dans ce domaine.  Accessible gratuitement,  la PDB compte actuellement plus 

de 164000 structures macromoléculaires biologiques dont plus de 150000 sont des protéines. Cette 

banque est universellement considérée comme une ressource de données essentielle pour comprendre 

les rôles fonctionnels que jouent les macromolécules en biologie et en médecine, elle donne accès à 

des données structurales tridimensionnelle 3D des macromolécules biologiques (protéines, ADN et 

ARN). Ces structures sont déterminées par différents techniques telles que la cristallographie aux 

rayons X et spectroscopie RMN [56][57][58].  
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Les coordonnées spatiales des structures se trouvent dans un fichier de format pdb, lu par différents 

logiciels de docking. Les positions atomiques sont spécifiées en coordonnées cartésiennes (x, y, z) en 

utilisant des unités Ångström [57].  

En cas où la cible n’est pas encore déposée au niveau de la PDB, il devient nécessaire de construire 

la structure 3D de la cible souhaitée en utilisant la modélisation par homologie basée sur la similitude 

des séquences que contient une autre protéine au niveau de cette banque de donnée [54].  

4.2 Les ligands 

Le choix du ligand est une étape très importante en docking moléculaire. Ce choix doit être pertinent 

en raison de la spécificité du site actif de la cible évitant de tester inutilement des molécules. Nous 

pouvons obtenir la structure d’un ligand donné sous forme 3D soit par : 

• L’utilisation des ligands de la littérature que nous pouvons dessiner, optimiser et sauvegarder 

dans différents formats (pdb, mol2….etc.) grâce à des logiciels de construction moléculaire tels 

que ChemDraw, MarvinSketch, ChemSketch. 

• La consultation des banques de données de ligands (chimiothèques) fournissant un nombre très 

important de structures 3D de ligands prêtes pour le docking. Parmi les chimiothèques les plus 

utilisés, nous pouvons citer la PubChem, Zinc, Chemspider [54].  

4.3 Les logiciels du docking  

Il existe de nombreux logiciels ou programmes de docking moléculaire. Les plus fréquemment cités 

sont respectivement : AutoDock, GOLD, Glide. Ces programmes reposent le plus souvent sur des 

algorithmes spécifiques. 

 

 Figure 24 : Logiciels utilisés dans toutes les publications de docking de 1990 à 2013. [59] 
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Tableau N°1 : Logiciels de docking et de leurs algorithmes. [46] 

 

 

5. Les interactions protéine-ligand 

La reconnaissance moléculaire a lieu lorsqu'un ou plusieurs sites d'interaction au niveau du 

récepteur et du ligand entrent en contact et définissent ainsi un motif de reconnaissance. Quand le 

nombre de points d'interaction entre le récepteur et le ligand augmente, l'énergie d'interaction 

augmente. Le phénomène de reconnaissance souvent combine plusieurs interactions souvent non 

covalentes. En particulier, les interactions de van der Walls, les liaisons hydrogènes, les interactions 

ioniques et les interactions hydrophobes [60].  

• Interactions de Van der Waals : Lorsque deux atomes se rapprochent l'un de l'autre, ils créent 

une force d'attraction faible et non spécifique qui produit une interaction de Van der Waals. 

Leur énergie d’interaction est d'environ 0.5 à 1 kcal/mol [60][61].  

• Liaisons Hydrogène : Elle s'établie lorsqu'un atome d'hydrogène lié à un atome électronégatif 

(donneur) se trouve à une distance d'interaction d'un atome électronégatif (accepteur). La 

liaison H est directionnelle (dépendance angulaire). Les forces des liaisons hydrogène dans les 

protéines et les acides nucléiques ne sont que de 2 à 5 kcal/mol [60][61].  

• Interactions ioniques : Elles résultent d’une force d’attraction électrostatique entre deux 

atomes de charges opposées. Les liaisons ioniques ont une force variant entre 5 et 10 kcal/mol 

dans un environnement aqueux [61].  

• Interactions hydrophobes : La force qui provoque l'agrégation des molécules hydrophobes ou 

des parties non polaires des molécules plutôt que de se dissoudre dans l'eau est appelée la liaison 

hydrophobe. La force d'une telle interaction est de 0,37 kcal/mol par groupe CH2. Par 
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conséquent, les molécules possédant de longues chaînes alkyles possèdent une valeur plus 

élevée de force hydrophobe qui peut être plus forte que les liaisons ioniques ou d'autres forces 

faibles. L'interaction hydrophobe peut aider à lier un médicament à son récepteur, ainsi qu'à 

stabiliser la structure protéique [61].  

• Interactions Pi-Pi (π-π stacking) : C’est un type particulier d’interactions non covalentes qui 

se forment entre deux cycles. Ces interactions jouent un rôle important dans le processus de 

reconnaissance d'une molécule de ligand et de son récepteur [61].  

 

Figure 25 : Illustration des différentes interactions protéine-ligand. [61] 
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1. Matériel 

Cette étude a pour objectif de proposer de nouveaux inhibiteurs de la Kynurénine 3-monooxygenase 

(KMO) en utilisant l’approche de modélisation par docking moléculaire. Pour atteindre nos objectifs, 

nous avons utilisé le matériel suivant : 

1.1 Ordinateur  

Tous les logiciels utilisés ont été installés sous le système d’exploitation Windows 10 professionnel 

64 bits (version 2019) dans un micro-ordinateur puissant ayant une mémoire vive (RAM) de 8 GO et 

un processeur Intel (R) Core (TM) i5 7éme génération. 

1.2 Logiciels et Serveurs  

Pour réaliser la partie pratique de notre travail, plusieurs logiciels ont été utilisés : 

1.2.1 AutoDock 

Tous les calculs de  docking moléculaire ont été réalisés en utilisant le programme AutoDock 4.2.6. 

Il se compose de deux sous-programmes principaux: AutoDock4 et AutoGrid4. AutoDock est conçu 

pour prédire comment de petites molécules se lient à un récepteur de structure 3D connue en 

s’appuyant sur l’algorithme génétique Lamarckian (AGL) [62].  L’interface graphique AutoDock 

Tools 1.5.6 a été simultanément utilisée pour faciliter la simulation avec AutoDock tout en permettant 

de visualiser ses résultats.  

1.2.2 Visual Molecular Dynamics (VMD) 

VMD 1.9.3 est un programme de modélisation et visualisation moléculaire conçu pour afficher, 

animer et analyser des assemblages moléculaires [63]. Ce logiciel qui a été développé par l’université 

de l'Illinois à Urbana-Champaign a été utilisé dans notre travail pour la préparation des protéines et 

des ligands étudiés. Il a été également utilisé pour la visualisation du positionnement des différents 

ligands au sein du site actif cible. 

1.2.3 Maestro 

Le logiciel Maestro 11.8 offre de nombreuses options de visualisation pour répondre aux besoins 

variés des différentes applications. Il apporte de la clarté à une large gamme de systèmes 

modélisés[64]. Nous avons utilisé Maestro pour la visualisation des complexes et des interactions 
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établies entre le site actif de l’enzyme et les inhibiteurs. Ce logiciel, géré et distribué par Schrödinger, 

a été utilisé aussi pour créer des images de haute qualité des complexes étudiés. 

1.2.4 Discovery Studio 

Discovery Studio est une suite de logiciels développé et distribué par Dassault Systemes BIOVIA 

permettant de simuler des systèmes à petites molécules et macromolécules [65]. Il a été utilisé pour 

générer les diagrammes 2D des interactions de chaque ligand avec la cible enzymatique KMO 

simplifiant l’analyse visuelle.  

1.2.5 ChemDraw 

ChemDraw s’est imposé depuis longtemps comme la référence des logiciels de construction des 

structures moléculaires. Il est géré et distribué par PerkinElmer [66]. Dans notre travail, nous avons 

utilisé ChemDraw 3D 16.0 pour la construction et la minimisation d’énergie des structures 

moléculaire des composés. 

1.2.6 OpenBabel 

Le logiciel libre OpenBabel 3.0.0 est un système expert en chimie principalement utilisé pour 

interconvertir des formats de fichiers chimiques [67]. Il nous a servi pour la conversion des fichiers 

de structures chimiques (e.g. pdb, mol2, sdf, smi). 

1.2.7 Microsoft Excel 

Microsoft Excel 2019 est un logiciel de la suite bureautique Microsoft Office développé et distribué 

par Microsoft. Il intègre des fonctions de calcul numérique, de représentation graphique, d'analyse de 

données et de programmation [68]. Ce logiciel nous a permet de calculer les Log IC50 des inhibiteurs, 

de tracer la droite de corrélation linéaire et calculer son coefficient. 

1.2.8 SwissADME 

L'outil SwissADME qui est développé par le groupe de modélisation moléculaire de l’Institut suisse 

de bioinformatique (SIB) permet d'évaluer si la molécule a des chances d'atteindre sa protéine cible 

dans l'organisme en termes d'absorption, de distribution, de métabolisme et d'excrétion (ADME) [69]. 

Les paramètres pharmacocinétiques et les propriétés physicochimiques des inhibiteurs proposés ont 

été prédits à l’aide de ce serveur rapide.  
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1.2.9 PreADMET 

PreADMET est un serveur permettant de prédire, et de calculer in silico les paramètres 

pharmacocinétiques et les propriétés physicochimiques et la toxicité potentielle par différents tests et 

modèles [70]. Cet outil qui appartient au complexe de recherche en ingénierie de l’université de Yonsei 

(en Séoul, Corée du sud) a été utilisé pour prédire la toxicité potentielle de nos inhibiteurs. 

1.3 Banques de données 

1.3.1 Protein Data Bank (PDB) 

La PDB est la principale source de données de structures 3D de macromolécules biologiques [58]. 

La structure 3D de notre enzyme d’intérêt ainsi que les complexes cristallographiques utilisés pour 

réaliser le test RMSD proviennent de cette banque. 

1.3.2 PubChem 

PubChem est une banque de données américaine de molécules chimiques gérée par le centre 

américain pour les informations biotechnologiques (National Center for Biotechnology Information, 

NCBI). Cette banque contient principalement de petites molécules, mais également des molécules 

plus grandes telles que des nucléotides, des glucides, des lipides, des peptides et des macromolécules 

chimiquement modifiées. Elle collecte les informations sur les structures chimiques, les identifiants, 

les propriétés chimiques et physiques, les activités biologiques, les données de toxicité…etc [71]. 

Cette chimiothèque répertoriant plus de 102 millions de composés a été utilisée afin d’obtenir les 

similaires structuraux de notre ligand de base. Les différentes conformations tridimensionnelles des 

modèles proposés par la PubChem dont les similaires sont téléchargeables sous format sdf. 

 

2. Méthodes 

2.1 La sélection de la protéine 

La KMO humaine n'est pas disponible dans la banque de données PDB en complexe avec un 

inhibiteur. Nous avons donc utilisé la KMO de Pseudomonas fluorescens (PfKMO) ayant un site actif 

conservée relativement à celui de l’espèce humaine [13]. À l’heure actuelle, il existe dans la PDB 11 

structures cristallographiques de complexes PfKMO-inhibiteur avec une résolution inférieure à 2 Å. 

Leurs codes pdb ainsi que leurs caractéristiques sont représentés dans le tableau N°2. 
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Tableau N°2: Code PDB des complexes PfKMO-Inhibiteur avec leurs caractéristiques. 

Code PDB 
Code de 

l’inhibiteur 
Résolution (Å) 

Nombre des 

chaines 

Nombre 

d’acides aminés 

5NAB 8RK 1.63 2 (A et B) 461 

6FOY E0T 1.65 2 (A et B) 460 

5NAG 8R5 1.68 2 (A et B) 461 

5MZI FYK 1.71 2 (A et B) 461 

5NAH 8RB 1.75 2 (A et B) 461 

5NAE 8R8 1.76 2 (A et B) 461 

5N7T JHY 1.81 2 (A et B) 461 

5MZC 8EQ 1.82 2 (A et B) 461 

5MZK OK1 1.82 2 (A et B) 461 

5X6Q 7ZR 1.90 1 (A) 463 

6FP1 E0Q 1.97 2 (A et B) 460 

 

Parmi ces structures cristallographiques, nous avons choisi celle portant le code 5NAB car elle 

possède la plus faible valeur de résolution (1.63 Å). 

 

Figure 26 : Représentation par Maestro de la structure 3D de la PfKMO (Code PDB : 5NAB).  

La chaine A en gris, la chaine B en cyan, l’inhibiteur 8RK en bleu, le FAD en rouge, l’ion de 

chlorure en vert, le glycérol en magenta et les molécules d’eau en rouge.  

Le complexe 5NAB nécessite une préparation avant de l’utiliser pour le docking moléculaire. à 

l’aide de VMD, la chaine B, les molécules d’eau, le glycérol, le FAD, l’inhibiteur de référence 8RK   
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ainsi que les ions de chlorure ont été éliminés pour ne garder que la chaine A de l’enzyme. La structure 

3D de notre cible préparée de la chaine A a été exportée sous le format .pdb. 

 

Figure 27 : Représentation par VMD de la chaine A du complexe 5NAB et sa cavité catalytique en 

présence de l’inhibiteur 8RK (jaune) et le FAD (rouge). 

2.2 La construction 3D des Ligands 

Les inhibiteurs faisant objet de notre étude ont été construits à l’aide de logiciel ChemDraw 3D. Par 

la suite, la géométrie de ces inhibiteurs a été optimisée par minimisation de leurs énergies 

intramoléculaire à l’aide du même programme avant de les exportés sous format mol2. 

2.3 Protocole d’utilisation d’AutoDock 

La procédure de docking moléculaire par AutoDock s’accomplit en cinq (5) étapes 

complémentaires : 

2.3.1 Préparation de l’enzyme 

La protéine doit être préparée à l’aide de sous-programme AutoTors en y ajoutant les hydrogènes 

polaires manquants. Ensuite, les charges de type "Kollman" ont été assignées avant l’exportation de 

la protéine sous format pdbqt. Les instructions de cette étape sont : 

✓ File > Read Molecule > 5nabprot.pdb > Ouvrir 

✓ Edit > Hydrogens > Add > Select Polar Only > OK 

✓ Edit > Hydrogens > Merge Non-Polar 
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✓ Edit > Charges > Add Kollman Charges > OK 

✓ Grid > Macromolecule > Choose > 5nabprot > Select Molecule > OK > Sauvegarder 

en format PDBQT (5nabprot.pdbqt) 

2.3.2 Préparation des inhibiteurs 

Les ligands précédemment construits à l’aide de logiciel ChemDraw 3D et enregistrés sous le format 

pdb ont été traités par AutoTors qui a fait le contrôle de leurs mouvements tout en définissant leurs 

atomes aromatiques, leurs liaisons flexibles ainsi que leurs angles de torsion. Toutes ces données ont 

été enregistrées sous le format pdbqt. Cette étape a été réalisée en suivant ces instructions : 

✓ File > Read Molecule > (sélectionner le fichier pdb de ligand) > Ouvrir 

✓ Edit > Hydrogens > Add > Select Polar Only > OK 

✓ Edit > Hydrogens > Merge Non-Polar 

✓ Ligand > Input > Choose > (sélectionner le ligand) > Select Molecule for AutoDock4 > Ok 

✓ Ligand > Output > Sauvegarder en format PDBQT 

2.3.3 Calcul des grilles de potentielle 

Lors de docking moléculaire, l’enzyme PfKMO est immergée dans une grille tridimensionnelle 

englobant largement son site actif et permettant la rotation libre rotation du ligand dans ce site. Le 

centre de cette boite a été déterminé par les coordonnées X = 9.923 ,Y = -32.329 , Z = 46.594 avec les 

dimensions 40*40*40 (Å) qui sont proportionnelles à la taille de tous les ligands étudiés. 

L’espacement ou la maille de la grille est fixé par défaut à 0.375 Å.  

Toutes ces instructions sont enregistrées dans un fichier texte avec l’extension gpf (Grid Parameters 

File). Par la suite, ce fichier est exécuté par le programme AutoGrid4 qui calcule les énergies 

d'interaction pour différents types d'atomes de la protéine et le ligand. Les résultats sont générés dans 

un fichier de format glg (Grid LoG file) qui sera très utile pour les calculs de docking moléculaire. 

Pour établir toutes ces étapes, nous avons exécuté ces instructions : 

✓ Grid > Macromolecule > Open > 5nabprot.pdbqt > Ouvrir > Yes > OK 

✓ Grid > Set Map Types > Open Ligand > (sélectionner le fichier pdbqt du ligand) > Ouvrir 

✓ Grid > Grid Box > Center > Remplir les coordonnées X, Yet Z > File > Close saving current 

✓ Grid > Output > Save GPF > Nom.gpf (Sauvegarder en format GPF) 
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✓ Run > Run AutoGrid > Remplir les cases > Launch 

 

Figure 28 : Position de la boite de docking dans le site actif de la PfKMO (code PDB : 5NAB) avec 

ses coordonnées et ses dimensions. 

2.3.4 Docking moléculaire 

Le docking moléculaire proprement dit est réalisé par le programme AutoDock4 qui nécessite un 

fichier texte avec l’extension dpf (Docking Parameters File). Pour lancer les calculs de docking 

moléculaire, ce fichier doit contenir les informations et les paramètres suivants :  

• Les noms des fichiers contenant le ligand et les grilles de potentiels à utiliser. 

• L’état initial du ligand (position, orientation et conformation aléatoire ou précisée). 

• L’algorithme de recherche à utiliser avec les paramètres associés. 

Dans notre étude, l’algorithme génétique de Lamarckian (AGL) a été utilisé avec ses paramètres 

par défaut. Pour établir cette étape, nous avons respecté les instructions suivantes : 

✓ Docking > Macromolecule > Set Rigid Filename > 5nabprot.pdbqt > Ouvrir 

✓ Docking > Ligand > Choose > (sélectionner le ligand) > Select Ligand > Accept 

✓ Docking > Search Parameters > Genetic Algorithm > Accept 

✓ Docking > Docking Parameters > Accept 

✓ Docking > Output > Lamarckian GA 4.2 > Nom.dpf (Sauvegarder en format DPF) 

✓ Run > Run AutoDock > Remplir les 3 cases > Launch 
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2.3.5 Analyse des résultats 

Les résultats de docking générés par le programme AutoDock4 sont fournis dans un fichier de 

format dlg (Docking LoG file). Ce fichier contient les dix (10) meilleures poses (conformations) 

simulées de chaque ligand étudié au sein du site actif de l’enzyme, leurs énergies d’interaction en 

kcal/mol (leurs scores), leurs valeurs de l’écart quadratique moyen (RMSD) ainsi que leurs constantes 

d’inhibition (Ki) en nM. 

La visualisation des interactions établies entre les meilleures conformations générées du ligand et 

le site actif peut se faire avec l'interface graphique AutoDock à partir du fichier .dlg.  

Dans cette étude, nous avons utilisé les deux logiciels Maestro et Discovery Studio Visualizer pour 

la visualisation des interactions protéine-ligand. 

2.4 Tests de fiabilité du programme AutoDock 

Avant d’entamer l’étude in silico de l’inhibition de la Kynurénine 3-monooxygenase par docking 

moléculaire, il a été primordial d’évaluer préalablement la fiabilité ou la performance du programme 

AutoDock. Dans ce contexte, nous avons effectué trois tests de fiabilité : 

• L’écart quadratique moyen ou le RMSD (Root Mean Square Deviation). 

• L’analyse visuelle. 

• Le coefficient de corrélation (r). 

2.4.1 Le test RMSD 

Le programme AutoDock prédit le positionnement d’une ligand au sein du site actif de la protéine. 

Souvent, la précision des poses de docking est quantifiée par le calcul de la RMSD entre la pose réelle 

déterminée expérimentalement du ligand dans le récepteur (la pose de référence) et celle calculée par 

l'algorithme de docking d’AutoDock (Self-docking). Les résultats de simulation sont fiables si les 

valeurs du RMSD sont inférieures à 2 Å [72]. 

Dans ce travail, le test RMSD a été réalisé sur 100 complexes (protéine-ligand) dont 11 complexes 

de PfKMO-inhibiteur et 89 complexes pris de façon aléatoire de la PDB. 
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2.4.2 L’analyse visuelle 

L’analyse visuelle qui est une étape complémentaire du test RMSD permet de confirmer les résultats 

du test RMSD et de vérifier la fiabilité des simulations. Cette visualisation nous permet donc de 

déterminer si un ligand simulé par AutoDock se superpose avec sa pose de référence. 

2.4.3 Le coefficient de corrélation (r) 

Le coefficient de corrélation linéaire, dit de Bravais-Pearson (ou de Pearson) permet de mettre en 

évidence l'intensité et le sens d’une relation linéaire entre deux variables. Cette valeur est comprise 

entre 1 et -1. La relation devient plus forte quand le coefficient s'approche des valeurs extrêmes 1 

(relation positive) ou -1 (relation négative) [73].  

 

Ce test a été utilisé pour évaluer le degré de corrélation linéaire entre les énergies d’interaction (ΔG) 

de 107 inhibiteurs de la KMO calculées par AutoDock et les valeurs de leurs IC50 déterminées 

expérimentalement et issues la littérature. 

2.5 Proposition de nouveaux inhibiteurs 

2.5.1 Criblage virtuel d’une collection de similaires 

Parmi les 107 inhibiteurs étudiés, nous avons choisi celui ayant présenté le plus faible score (la 

meilleure énergie d’interaction) pour poursuivre notre étude. Cet inhibiteur est très puissant mais ne 

peut pas pénétrer la barrière hémato-encéphalique (blood–brain barrier, abrégé BBB). Afin 

d’améliorer davantage aussi bien son score (activité inhibitrice) que sa capacité à traverser la BBB, ce 

composé a été utilisé comme structure de départ pour obtenir une petite chimiothèque de composés 

similaires via la PubChem.  

Avec un taux de similarité de 82%, cette banque de données nous a proposé 352 composés similaires 

de notre structure de départ. Ces similaires ont été téléchargés sous format sdf puis convertis en mol2 

à l’aide du programme OpenBabel. Comme pour les autres ligands, ces similaires ont été préparés et 

enregistrés en format pdbqt ; format d’entrée requis pour le docking avec AutoDock. Cette collection 

de similaires a fait l’objet de criblage virtuel. 
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2.5.2 Modification par substitution 

Suite au criblage virtuel, nous avons fait appel à une seconde approche où le composé similaire 

ayant présenté le meilleur score (la meilleure énergie d’interaction) a subi des modifications 

structurales par substitution afin d’améliorer son score ainsi que son profil ADMET et plus 

particulièrement sa capacité de franchir la barrière hémato-encéphalique. Nous avons effectués des 

mono-substitutions et des poly-substituions faisant un total de 62 substitutions. Les groupements 

fonctionnels ajoutés sur la structure du composé de départ dans différentes positions sont présentés 

dans la figure N°29. 

 

Figure 29 : Les fonctions ajoutés au cours de la mono-substitution. 

Ces substituions ont été effectuées à l’aide du logiciel ChemDraw et enregistrées sous format mol2.  

2.6 Les propriétés ADMET 

Pour qu’une molécule puissante ayant une affinité qui lui confère une activité biologique puisse 

parvenir jusqu’à sa cible dans l’organisme, elle doit réussir à passer par divers obstacles pour y arriver 

avec une concentration suffisante pour que les événements biologiques attendus se produisent. Les 

études ADMET jouent un rôle crucial étant un élément essentiel de la découverte et du développement 

des médicaments.  

Dans ce travail, nous avons utilisé le serveur SwissADME afin de prédire les propriétés 

physicochimiques et pharmacocinétique in silico régissant les paramètres ADME des composés 

d’intérêt. Par la suite, plusieurs critères de toxicité ont été prédits via le serveur PreADMET. 
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2.6.1 Propriétés physicochimiques 

 La règle de Lipinski (Ro5) 

En 1997, Lipinski et al ont proposés « la règle de Lipinski » également appelée « règle de 5 » qui 

permet d’évaluer la biodisponibilité d’un composé chimique par voie orale à partir de sa structure 

bidimensionnelle (2D). Selon cette règle, un composé doit valider au moins trois des cinq (3/5) critères 

suivants pour avoir la chance d’être disponible oralement : 

• Le poids moléculaire (PM) ≤ 500 daltons (Da). 

• Le nombre d’accepteurs de liaison hydrogène (O et N) ≤ 10. 

• Le nombre de donneurs de liaison hydrogène (OH et NH) H ≤ 5. 

• Le nombre de liaisons rotatives <15. 

• Le coefficients de partition octanol/eau (logP) ≤ 5 [74].  

 La règle de Veber 

En plus des travaux de Lipinski, des études par Veber et al en 2002 suggèrent que les composés qui 

valident les deux critères suivants, présentaient généralement une bonne biodisponibilité orale : 

• La surface polaire de la molécule (TPSA) ≤ 140 Å² 

• Le nombre de liaisons à libre rotation ≤ 10 [75].  

 La solubilité dans l’eau 

Une mauvaise solubilité des médicaments est l'un des principaux obstacles au processus de 

découverte et de développement de médicaments. Une solubilité acceptable est une condition 

préalable pour atteindre des concentrations médicamenteuses suffisamment élevées pour obtenir un 

effet thérapeutique [76].  

 Accessibilité à la synthèse 

L'évaluation de l'accessibilité synthétique d'un composé est un aspect important dans le processus 

de la conception des médicaments car dans certains cas, les composés conçus in silico ne peuvent pas 

être synthétisés [77]. Dans notre travail, l’accessibilité à la synthèse chimique a été évaluée en valeurs 

allant de 1 (très facile à synthétiser) jusqu’à 10 (très difficile à synthétiser). 
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2.6.2 Propriétés pharmacocinétiques 

 L’absorption gastro-intestinal 

Pour le développement de produits pharmaceutiques oraux, l'étude des processus de perméabilité 

intestinale des médicaments est cruciale. Pour qu’un médicament soit absorbé, accède au sang puis 

d'attendre sa cible, il doit être capable de traverser le tractus gastro-intestinal [78]. La barrière 

intestinale couvre une surface d’environ 400 m² comprenant une monocouche de cellules organisées 

en cryptes et en villosités. Elle possède des fonctions métaboliques, digestives et immunologiques. Le 

transport des molécules à travers cette barrière est médié par des processus passifs ou actifs [78][79].  

 La perméabilité BBB 

La barrière hémato-encéphalique (BBB) chez l'homme est formée par des jonctions serrées 

spécialisées entre les cellules endothéliales qui tapissent les capillaires cérébraux. C'est une barrière 

de perméabilité rigoureuse et hautement sélective séparant le cerveau du sang circulant. La BBB 

empêche la plupart des composés externes (98%) de pénétrer dans le système nerveux central (SNC) 

afin de maintenir l'homéostasie du SNC [80].  

De nombreux composés testés ont échoué en raison du manque de capacité à pénétrer la barrière 

hémato-encéphalique plutôt que du manque de puissance, ce qui a provoqué un goulot d'étranglement 

dans la découverte de médicaments cibles du SNC [80].  

 L’inhibition des Cytochromes P450 

Les enzymes CYP sont considérées comme l'une des familles d'enzymes les plus importantes car 

elles jouent un rôle dominant dans la biotransformation d'un vaste nombre de médicaments. Elles 

existent sous plusieurs isoformes (e.g. CYP1A2, CYP2D6). Les interactions médicamenteuses 

résultent de l’induction ou l’inhibition d'une ou de plusieurs enzymes du cytochrome P450 par des 

médicaments. Cela cause une diminution du métabolisme des autres molécules métabolisées par les 

isoformes inhibées, d’en augmenter leurs concentration plasmatique, de prolonger leurs effets 

thérapeutiques et de déclencher éventuellement des effets indésirables voir même toxique [81][82].  

C’est pour cela que l'évaluation du potentiel d'un médicament candidat à inhiber ou à inactiver les 

enzymes du cytochrome P450 (CYP) demeure une partie importante dans le processus de découverte 

et de développement de médicaments pharmaceutiques [83].  
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2.6.3 Tests de toxicité 

Pendant le développement du médicament, la sécurité est toujours le problème le plus important qui 

doit être évalué dans les phases des essais précliniques et cliniques. De nombreuses méthodes in silico 

ont été développées dans laquelle la toxicité peut être prédite directement à partir de la structure 

chimique. Ces approches de toxicologie in silico aident à réduire les expériences sur les animaux, en 

nous faire gagner du temps et de l'argent. Nous avons utilisé le serveur PreADMET afin de prédire la 

toxicité potentielle de nos inhibiteurs d’intérêt. 

 Le test d’AMES 

Le test de mutation bactérienne reverse (test d'Ames) est l'un des tests les plus largement utilisés 

pour l'identification des substances mutagènes. Ce test consiste en des sous-tests parallèles dans 

lesquels chacune des souches bactériennes testées de Salmonella typhimurium est exposée à la 

substance d'intérêt. Chaque souche a une mutation différente dans un gène nécessaire à la synthèse de 

l'histidine indispensable à sa croissance. Si l'exposition à la substance d'intérêt permet à la cellule 

mutée de produire l'histidine nécessaire pour se développer sur un milieu de culture dépourvu de ce 

dernier, la substance est considéré comme un mutagène [84].  

 Le test de la cancérogénicité 

Pour prédire si une substance ou un produit donné, a un pouvoir carcinogène pour l'homme, les 

études se fondent actuellement sur les données des essais biologiques sur la cancérogénicité chez deux 

espèces des rongeurs, généralement le rat et la souris [85][86].  

 Le test de l’inhibition de hERG 

La toxicité cardiaque est l'un des effets secondaires et une des principales causes de retrait de 

médicaments lors de la découverte de médicaments. Les candidats-médicaments provoquent souvent 

un blocage indésirable du canal des ions potassium de hERG (human ether-a-go-go-related gene) qui 

entraîne un syndrome du QT long (LQTS), et conduit éventuellement à des arythmies ventriculaires 

fatales et à une mort subite [87].  

 Les tests de la toxicité aigue 

Le test de la toxicité aigüe sur les algues : Il mesure les effets d'inhibition de la croissance d'une 

population exposée aux solutions testées sur une période de 72h. Ce test sensible qui permet de 

détecter des effets toxiques à faible concentration est inclus dans l'ensemble de base des tests éco-
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toxicologiques recommandés par l'Organisation de coopération et de développement économiques 

(OCDE) et est légalement exigé pour de nouveaux produits chimiques [88][89].  

Le test de la toxicité aigüe de Daphnia : L'une des raisons pour lesquelles Daphnia magna est un 

animal d'essai couramment utilisé en toxicologie aquatique est qu'il est facilement cultivé en 

laboratoire, les Daphnia sont également parmi les organismes les plus sensibles. Le test est réalisé 

dans un milieu synthétique, auxquels le composé à tester est ajouté à différentes concentrations 

maintenues constantes pendant la durée de l'essai [90].  

Le test de la toxicité aigüe sur les poissons : Les petits poissons couramment utilisés comme 

modèles de recherche en toxicologie sont en grande partie des espèces d'eau douce, comme le tête-de-

boule (Pimephales promelas), le medaka japonais (Oryzias latipes) [91].  

Le Medaka japonais est fréquemment utilisé pour les tests de toxicité. Les tests peuvent évaluer la 

neurotoxicité chez les embryons en développement, les effets toxiques sur le phénotype sexuel, ou 

l’hépatotoxicité chez les poissons adultes [92].  

Le tête-de-boule (fathead minnow en anglais) s'est avérée susceptible d'être cultivée en continu dans 

des laboratoires du monde entier car cette espèce est tolérante à plusieurs types d'eau, et son cycle de 

reproduction/ développement est relativement bien défini. Le tête-de-boule a été utilisé dans de  

nombreux tests allant de la létalité de 48 h aux tests de cycle de vie partiel et complet pour l’évaluation 

des risques potentiels de nouveaux produits chimiques [91].  
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1. Tests de fiabilité du programme AutoDock 

Pour évaluer la fiabilité du programme AutoDock, nous avons appliqué trois tests : 

1.1 Le test RMSD 

Ce test a été effectué sur cent (100) complexes protéine-ligand tirés de manière arbitraire de la PDB. 

Il consiste à calculer le RMSD entre la position d’un ligand simulée par le logiciel et celle de référence 

(expérimentale). Les prédictions sont jugées fiables si les valeurs de RMSD sont inférieures à 2 Å[72].  

Les 100 complexes étudiés avec leurs codes PDB et leurs valeurs de RMSD obtenues sont 

représentés dans l’annexe N°1. Le diagramme circulaire ci-dessous (figure N°30) représente les 

résultats de ce test donnés en pourcentage (%), à deux intervalles. Alors que l'histogramme (figure 

N°31) les représente en pourcentage (%) à divers intervalles. 

 

Figure 30 : Résultats en pourcentage du test RMSD par AutoDock à deux intervalles. 

 

Figure 31 : Histogramme en pourcentage du test RMSD par AutoDock à divers intervalles. 
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Il est montré dans la figure N°30 que 82% des valeurs RMSD sont inférieures à 2 Å, tandis que 

seulement 18% sont supérieurs à cette valeur seille (2 Å). Ceci montre l’efficacité d’AutoDock à 

reproduire correctement des poses cristallographiques. Il est également à souligner que la totalité des 

onze complexes PfKMO-Inhibiteur testés ont affiché un RMSD inférieur à 2 Å (voir tableau N°3). De 

plus, la figure N°31 révèle que plus de la moitié des complexes testés avaient un RMSD inférieure à 

1 Å. La  moyenne calculée des RMSD des 100 complexes est de 1,3 Å. Les résultats obtenus sont en 

accord avec travaux de Chikhi A. et Bensegueni A. (2008) [93] et Gabb J. et al (1997) [94] ce qui 

prouve la fiabilité du logiciel AutoDock.  

1.2 L’analyse visuelle 

Suite au test par RMSD, l’analyse visuelle est une étape primordiale pour vérifier davantage la 

fiabilité des simulations de docking par AutoDock et en même temps de confirmer les résultats de 

RMSD. Cette visualisation permet donc de déterminer si un ligand simulé se superpose avec sa pose 

de référence. Dans notre étude, l’analyse visuelle a été effectuer sur quatre (4) complexes parmi les 

onze (11) complexes PfKMO-Inhibiteur testés afin de nous assurer de la performance d’AutoDock 

envers les inhibiteurs de notre enzyme cible. Il s’agit bien des complexes 5NAB, 6FP1, 5NAE et 

6FPH. La figure N°32 représente les résultats de cette visualisation. 

Tableau N°3: Les valeurs de RMSD des onze complexes PfKMO-Inhibiteur étudiés. 

N° Code PDB Code des ligands RMSD 

1 5NAB 8RK 0.27 

2 6FP1 E0Q 0.30 

3 5N7T JHY 0.40 

4 5NAE 8R8 0.43 

5 6FPH E1W 0.45 

6 5FN0 JHY 0.48 

7 6FP0 E0N 0.56 

8 5NAG 8R5 0.64 

9 5NAH 8RB 0.85 

10 6FOZ E0H 1.61 

11 6FOY E0T 1.67 

 

Comme le montre la figure N°32, les modèles des ligands 8RK, E0Q, 8R8, E1W simulés par 

AutoDock (colorés en rouge) présentent des conformations spatiales parfaitement superposables à 
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celles déterminées expérimentalement par cristallographie (colorés en bleu). Cela témoigne davantage 

de la fiabilité du programme AutoDock pour l’étude in silico de l’inhibition de PfKMO. 

 

Figure 32 : Comparaison entre les poses du ligand simulés par AutoDock (en rouge) et les poses 

obtenues par cristallographie aux rayons X (en bleu). 

1.3 Le coefficient de corrélation (r) 

Ce test a pour but d’évaluer le degré de corrélation linéaire existant entre les énergies d’interaction 

(ΔG) des inhibiteurs de la KMO calculés par AutoDock et les valeurs de leurs IC50 déterminées 

expérimentalement. Pour réaliser ce test, nous avons utilisé 107 inhibiteurs de la KMO issus de la 

littérature. Nous avons employé les valeurs de Log IC50 car les valeurs des IC50 sont très divergentes.  
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Les résultats des énergies d’interactions des inhibiteurs étudiés, leurs IC50, ainsi que leurs Log IC50 

sont représentés dans le tableau N°4.  Les structures de ces composés sont représentés dans l’annexe 

N°2.  

Tableau N°4 : Les énergies d’interaction des 107 inhibiteurs de la KMO, leurs IC50 et Log IC50. 

Composé IC50 (µM) Log IC50 ΔG (kcal/mol) Référence 

C1 0.12 -0,921 -8.76 [95] 

C2 0.9 -0,046 -7.59 [96] 

C3 0.2 -0,699 -8.40 [97] 

C4 0.0005 -3,301 -9.11 [10] 

C5 900 2,954 -7.14 [98] 

C6 13.6 1,134 -6.72 [99] 

C7 0.003 -2,523 -10.46 [16] 

C8 0.0043 -2,367 -8.73 [16] 

C9 0.06 -1,222 -8.60 [16] 

C10 6.309 0,800 -7.37 [15] 

C11 1 0,000 -7.68 [15] 

C12 0.050 -1,301 -8.00 [15] 

C13 5.011 0,700 -8.40 [15] 

C14 2.511 0,400 -8.41 [15] 

C15 0.631 -0,200 -8.20 [15] 

C16 2.511 0,400 -8.55 [15] 

C17 3.162 0,500 -8.07 [15] 

C18 1.995 0,300 -7.87 [15] 

C19 0.125 -0,903 -8.13 [15] 

C20 0.501 -0,300 -8.06 [15] 

C21 0.025 -1,602 -8.27 [15] 

C22 0.079 -1,102 -8.39 [15] 

C23 0.630 -0,201 -8.38 [15] 

C24 1 0,000 -7.86 [15] 

C25 5.011 0,700 -8.00 [15] 

C26 0.039 -1,409 -8.30 [15] 

C27 3.162 0,500 -7.86 [15] 

C28 0.063 -1,201 -8.51 [15] 

C29 0.5 -0,301 -8.64 [13] 
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C30 0.1 -1,000 -8.80 [15] 

C31 0.039 -1,409 -8.22 [15] 

C32 0.1 -1,000 -8.80 [15] 

C33 0.012 -1,921 -8.27 [15] 

C34 0.005 -2,301 -8.40 [15] 

C35 0.079 -1,102 -8.56 [15] 

C36 0.04 -1,398 -9.46 [6] 

C37 0.012 -1,921 -8.60 [14] 

C38 0.012 -1,921 -9.45 [14] 

C39 0.01 -2,000 -8.72 [14] 

C40 0.025 -1,602 -9.30 [14] 

C41 0.031 -1,509 -8.27 [14] 

C42 0.002 -2,699 -10.39 [14] 

C43 0.005 -2,301 -10.75 [14] 

C44 0.003 -2,523 -10.67 [14] 

C45 0.005 -2,301 -10.87 [14] 

C46 0.002 -2,699 -10.42 [14] 

C47 9.31 0,969 -5.97 [95] 

C48 123.4 2,091 -7.73 [95] 

C49 85.6 1,932 -7.72 [95] 

C50 100.8 2,003 -7.83 [95] 

C51 4.3 0,633 -8.50 [95] 

C52 72.1 1,858 -7.54 [95] 

C53 0.4 -0,398 -8.97 [95] 

C54 6.3 0,799 -7.62 [95] 

C55 2.4 0,380 -8.43 [95] 

C56 0.0016 -2,796 -9.13 [100] 

C57 0.1 -1,000 -7.66 [100] 

C58 5.77 0,761 -7.28 [101] 

C59 2.68 0,428 -7.97 [101] 

C60 0.114 -0,943 -9.73 [101] 

C61 0.47 -0,328 -9.08 [101] 

C62 0.24 -0,620 -9.42 [101] 

C63 0.056 -1,252 -9.18 [101] 

C64 0.076 -1,119 -9.13 [101] 
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C65 0.056 -1,252 -9.86 [101] 

C66 0.039 -1,409 -8.75 [101] 

C67 0.019 -1,721 -8.87 [101] 

C68 0.1 -1,000 -8.66 [102] 

C69 1.9 0,279 -7.59 [102] 

C70 0.32 -0,495 -8.18 [102] 

C71 0.58 -0,237 -7.27 [102] 

C72 0.9 -0,046 -6.96 [102] 

C73 0.5 -0,301 -8.06 [102] 

C74 0.0006 -3,222 -9.12 [10] 

C75 0.038 -1,420 -8.10 [10] 

C76 0.99 -0,004 -8.00 [10] 

C77 0.34 -0,469 -8.07 [10] 

C78 16.7 1,223 -6.99 [10] 

C79 1.3 0,114 -8.53 [10] 

C80 0.0032 -2,495 -9.42 [10] 

C81 0.09 -1,046 -9.43 [10] 

C82 0.012 -1,921 -9.30 [10] 

C83 0.14 -0,854 -7.90 [10] 

C84 0.01 -2,000 -8.39 [10] 

C85 0.26 -0,585 -7.80 [10] 

C86 0.002 -2,699 -9.75 [10] 

C87 0.012 -1,921 -9.70 [10] 

C88 0.025 -1,602 -10.17 [10] 

C89 4 0,602 -7.79 [10] 

C90 1.7 0,230 -6.80 [10] 

C91 0.011 -1,959 -8.32 [10] 

C92 0.019 -1,721 -9.04 [10] 

C93 0.076 -1,119 -7.81 [10] 

C94 0.038 -1,420 -8.27 [10] 

C95 0.005 -2,301 -8.82 [10] 

C96 0.022 -1,658 -8.51 [10] 

C97 6.51 0,814 -7.95 [10] 

C98 0.017 -1,770 -8.50 [10] 

C99 0.032 -1,495 -8.49 [10] 
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C100 0.0007 -3,155 -9.10 [10] 

C101 0.06 -1,222 -8.75 [10] 

C102 0.006 -2,222 -9.21 [10] 

C103 0.049 -1,310 -9.20 [10] 

C104 0.0015 -2,824 -9.61 [10] 

C105 0.012 -1,921 -9.51 [10] 

C106 0.002 -2,699 -9.18 [10] 

C107 0.057 -1,244 -9.91 [10] 

 

 

Figure 33 : Corrélation linéaire entre les Log IC50 et les énergies d’interaction (ΔG) des 107 

inhibiteurs étudiés. 

L’analyse par régression linéaire réalisée entre les énergies d’interaction et les IC50 (Log IC50) des 

107 inhibiteurs étudiés génère un nuage de points (voir figure N°33) avec un coefficient de corrélation 

égal à 0.70 et montre ainsi que ces deux variables évoluent dans le même sens et presque avec la même 

intensité. Il existe donc une certaine  corrélation linéaire positive entre ces deux variables. Ces résultats 

preuve, encore une fois, que le programme AutoDock est hautement performent, conformément aux 

travaux de Mokrani E. H. qui ont également révélés un coefficient de corrélation nettement supérieur 

à 0.5 [54]. 

Conclusion 

Les différents tests utilisés dans cette étude pour évaluer la qualité de programme AutoDock, le test 

RMSD, l’analyse visuelle et l’étude de la corrélation nous ont permet de conclure que AutoDock est 
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un programme hautement performant et fiable. Il peut donc être utilisé, sans grands risque d’erreurs, 

pour étudier in silico l’inhibition de KMO par différents ligands. 

 

2.    Etude des interactions de PfKMO-inhibiteur 

À l'issue du test de corrélation linéaire, nous avons sélectionné le composé C45 (voir tableau N°4) 

qui a révélé le meilleur score (-10.87 kcal/mol) parmi les 107 inhibiteurs étudiés. Ce composé faisant 

partie de la classe des benzisoxazoles inhibe fortement la KMO aussi bien théoriquement que 

expérimentalement avec un IC50 égale à 5 nM. 

 

Figure 34 : Représentation par Maestro du positionnement du C45 dans le site actif de la PfKMO. 

 

 

Figure 35 : Diagrammes des interactions entre le ligand C45 et la PfKMO. 
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L’analyse visuelle montre que le composé C45 se place correctement dans la cavité catalytique de 

l’enzyme ou il établit 5 liaisons hydrogène : 

• La première est formée entre l’azote (N) de cycle pipéridine de l’inhibiteur et la fonction amine 

(NH2) du résidu ALA56 avec une distance de 1.84 Å. 

• La deuxième est observée entre l’oxygène (O) de groupement carboxyle (COOH) de l’inhibiteur 

et le groupement amine secondaire (NH) du résidu ARG84 avec une distance de 1.62 Å. 

• La troisième est située entre le groupement carboxyle (COOH) de l’inhibiteur et l’oxygène (O) 

de groupement hydroxyle (OH) du résidu TRY98 avec une distance de 2.03 Å. 

• Les deux dernières liaisons hydrogène font intervenir le deuxième oxygène (O) du groupement 

carboxyle (COOH) de l’inhibiteur qui se lie avec le groupement amine (NH2) de l’ASN369 

(distance de 2.02 Å), ainsi que la fonction amine (NH2) de l’ARG84 avec une distance de 1.92Å.  

Le complexe PfKMO-Composé C45 est également stabilisé par de nombreuses interactions 

hydrophobes avec les 11 résidus : LEU55, ALA56, TYR98, ILE106, LEU213, ILE215, ILE224, 

PRO318, PHE319, MET373, TYR404. 

Nous avons simulé au préalable les propriétés pharmacocinétiques de composé C45 (voir tableau 

N°5 et figure N°36) à l’aide du serveur SwissADME, ce composé a présenté un résultat négatif 

inhérent à la perméabilité de la barrière hémato-encéphalique. L'objectif principal de notre travail est 

de proposer de nouveaux inhibiteurs capables de franchir cette barrière et peut ainsi atteindre la cible 

au niveau du système nerveux central, tout en améliorant leurs score. 

Tableau N°5 : Les propriétés pharmacocinétiques de composé C45. 

Propriétés Composé C45 

GI absorption Élevée 

BBB perméabilité Non 

CYP1A2 inhibition Oui 

CYP2C19 inhibition Oui 

CYP2C9 inhibition Oui 

CYP2D6 inhibition Non 

CYP3A4 inhibition Non 
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Figure 36 : La structure du composé C45. 

 

3. Proposition de nouveaux inhibiteurs 

3.1 Criblage virtuel d’une collection de similaires 

Le composé C45 a été pris comme structure de départ afin de rechercher dans la PubChem des 

composés similaires, cette chimiothèque nous a fournis une collection de 352 composés similaires 

avec un taux de similarité allant jusqu’au 82 %. Le docking moléculaire de ces similaires avec la 

PfKMO fait ressortir 46 composés (13.06% du total des similaires) présentent une énergie 

d’interaction inférieure à celle du composé de départ (-10.87 kcal/mol). Les numéros d’accession, 

ainsi que les scores de docking des 352 composés similaires sont représentés dans l’annexe N°3. Le 

tableau N°6 ci-dessous affiche les 10 meilleurs similaires classés selon leurs score. 

Tableau N°6 : Numéro d’accession et score des dix (10) meilleurs inhibiteurs obtenus suite au 

docking moléculaire de la collection de similaires du composé C45. 

Composé Numéro d’accession CID ΔG (kcal/mol) 

S185 CID_121415087 -12,06 

S276 CID_135139688 -12,02 

S158 CID_121415048 -11,89 

S159 CID_121415049 -11,82 

S163 CID_121415057 -11,74 

S102 CID_68920380 -11,70 

S162 CID_121415052 -11,67 
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S182 CID_121415083 -11,66 

S219 CID_121415172 -11,64 

S203 CID_121415130 -11,62 

 

Le criblage virtuel de la collection de similaires chimiques du composé C45 fait ressortir le composé 

S185 comme le meilleur inhibiteur potentiel de notre cible avec une énergie d’interaction égale à -

12.06 kcal/mol. 

 

Figure 37 : Représentation par Maestro du positionnement du composé S185 dans le site actif de la 

PfKMO. 

 

 

Figure 38 : Diagrammes des interactions entre le ligand S185 et la PfKMO. 
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La visualisation du mode d’interaction de composé S185 au sein du site actif de la PfKMO révèle 

la mise en place de quatre (4) liaisons hydrogène : 

• La première est formée entre l’oxygène (O) de groupement carboxyle (COOH) de l’inhibiteur et 

le groupement amine secondaire (NH) du résidu ARG84 avec une distance de 1.71 Å. 

• La deuxième est située entre le groupement carboxyle (COOH) de l’inhibiteur et l’oxygène (O) 

de groupement hydroxyle (OH) du TRY98 avec une distance de 1.93 Å.  

• Les deux autres liaisons hydrogène font intervenir le deuxième oxygène (O) de groupement 

carboxyle (COOH) de l’inhibiteur et le de groupement amine (NH2) du résidu ASN369 (distance 

de 2.09 Å), ainsi qu’avec la fonction amine (NH2) du résidu ARG84 (distance de 1.83 Å).  

De plus, plusieurs interactions hydrophobes sont formées entre l’inhibiteur (S185) et les 13 résidus 

LEU55, ALA56, TYR98, ILE106, LEU213, ILE215, ILE224, LEU226, PRO318, PHE319, MET324, 

MET373, et TYR404 du site actif de l’enzyme. 

En tenant compte de la marge d’erreur de 2 kcal/mol tolérée par AutoDock, l’amélioration de 

l’énergie d’interaction pour le composé S185 n’est pas significative. De plus, ce composé s’est avéré 

incapable de franchir la barrière BBB pour atteindre son lieu d’action au niveau du SNC (tableau N°7). 

Par conséquent, nous avons fait appel à seconde approche basée sur la modification de la structure du 

composé S185 en y introduisant des groupes fonctionnels dans différentes positions, dans l’espoir de 

proposer de nouveaux inhibiteurs plus puissants avec un meilleur profil ADME. 

Tableau N°7 : Les propriétés pharmacocinétiques de composé S185. 

Propriétés Composé S185 

GI absorption Élevée 

BBB perméabilité Non 

CYP1A2 inhibition Oui 

CYP2C19 inhibition Oui 

CYP2C9 inhibition Oui 

CYP2D6 inhibition Non 

CYP3A4 inhibition Oui 
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3.2 Modification par substitution 

Le composé S185 a subi plusieurs modifications structurales différentes positions afin  d’améliorer 

non seulement son affinité à l’égard de la cible, mais aussi son profil ADMET, particulièrement sa 

capacité à franchir la barrière BBB.  

3.2.1 Les mono-substitutions 

Dans un premier temps, une série de mono-substitution du composé S185 sur les positions R1 et 

R2 (voir figure N°39) a été réalisé  en faisant appel à 24 substituants. Le docking moléculaire des 48 

composés qui en résultent fait ressortir le composé M22 comme meilleur inhibiteur de la KMO 

(tableau N°8).   

 

Figure 39 : Représentation des positions des radicaux R1 et R2 dans la structure de base du 

composé S185. 

Tableau N°8 : Les énergies d’interaction (scores) des 48 composés monosubstitués et leurs BBB 

perméabilité. 

Composé 

mono-substitué 
R1 R2 

Score 

(kcal/mol) 

BBB 

Perméabilité 

M1 OMe  -11.69 Non 

M2 OEt  -11.99 Non 

M3 OH  -11.15 Non 

M4 COOH  -10.91 Non 

M5 COH  -11.92 Non 

M6 NH2  -12.05 Non 

M7 NO  -11.67 Non 
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M8 SH  -11.66 Non 

M9 Cl  -12.14 Non 

M10 F  -11.57 Non 

M11 CF3  -11.77 Non 

M12 Br  -12.48 Non 

M13 CN  -12.28 Non 

M14 CONH2  -12.41 Non 

M15 Benzène  -12.92 Non 

M16 Cyclopentane  -12.39 Non 

M17 Pyridine  -12.56 Non 

M18 Pyrimidine  -12.94 Non 

M19 Imidazole  -11.70 Non 

M20 Cyclobutane  -12.64 Non 

M21 Cyclopropane  -12.26 Non 

M22 Pipéridine  -13.42 Non 

M23 Pyrrolidine  -13.16 Non 

M24 Azétidine  -12.77 Non 

M25  OMe -11.77 Non 

M26  OEt -11.91 Non 

M27  OH -11.23 Non 

M28  COOH -10.75 Non 

M29  COH -11.68 Non 

M30  NH2 -11.49 Non 

M31  NO -11.81 Non 

M32  SH -11.92 Non 

M33  Cl -11.86 Non 

M34  F -11.49 Non 

M35  CF3 -11.54 Non 

M36  Br -12.09 Non 

M37  CN -11.89 Non 

M38  CONH2 -11.50 Non 

M39  Benzène -12.96 Non 

M40  Cyclopentane -12.91 Non 

M41  Pyridine -12.82 Non 

M42  Pyrimidine -12.76 Non 
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M43  Imidazole -12.57 Non 

M44  Cyclobutane -12.84 Non 

M45  Cyclopropane -12.36 Non 

M46  Pipéridine -13.30 Non 

M47  Pyrrolidine -12.82 Non 

M48  Azétidine -12.49 Non 

 

 

Figure 40 : Représentation par Maestro du positionnement du composé M22 dans le site actif de la 

PfKMO. 

 

 

Figure 41 : Diagrammes des interactions entre le ligand M22 et la PfKMO. 
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L’introduction du groupement pipéridine en position R1 à la place du méthyle (CH3) dans la 

structure de départ (composé S185) améliore l’énergie d’interaction pour la cible qui passe de -12,06 

kcal/mol dans le cas du composé S185 à -13.42 kcal/mol dans le cas du composé M22.  L’analyse 

visuelle révèle la présence de 4 liaisons hydrogène.  

• La première est située entre l’azote (N) de cycle pyridazine de l’inhibiteur et la fonction amine 

(NH2) du résidu ALA56 avec une distance de 1,79 Å.  

• La deuxième est formée entre la fonction carboxyle (COOH) de l’inhibiteur et l’oxygène (O) de 

groupement hydroxyle (OH) du résidu TRY98 avec une distance de 2.12 Å.  

• Les deux dernières liaisons hydrogène font intervenir le deuxième oxygène (O) de groupement 

carboxyle (COOH) de l’inhibiteur qui se lie aussi bien avec la fonction amine (NH2) du résidu 

ASN369, qu’avec la fonction amine (NH2) du résidu ARG84 (distance de 2.44 Å et de 1.91 Å 

respectivement). 

De plus, de nombreuses interactions hydrophobes participent à la stabilité du complexe M22-

PfKMO. Ces interactions font intervenir les 13 résidus : LEU55, ALA56, TYR98, LEU213, ILE215, 

ILE224, LEU226, PHE238, PRO318, PHE319, MET324, MET373 et TYR404 du site actif de 

l’enzyme. 

Cependant, le composé M22 ne peut pas traverser la barrière hémato-encéphalique (BBB) pour 

atteindre sa cible bien qu’il présente un bon score. Raison pour laquelle, nous avons poursuit nos 

investigations dans la recherche de nouveaux inhibiteurs aussi puissants tout en présentant un meilleur 

profil ADMET.   

3.2.2 Les poly-substitutions  

Le composé M22 a subi une série de poly-substitution dans plusieurs positions qui sont R3, R4, et 

R5 (voir figure N°42) pour diminuer davantage son énergie d’interaction tout en améliorant son profil 

ADMET, particulièrement sa perméable au BBB. Dans cette optique, nous avons utilisé 14 nouveaux 

groupements (tableau N°9), lesquels sont introduits dans de nouvelles positions de la structure de 

départ (R3, R4 et R5). Il est à souligner que les groupements utilisés lors de la mono-substitution 

(figure N°29 et tableau N°8) ont été également utilisés lors de la poly-substitution. Ces dernières n’ont 

pas été représentés dans le tableau N°9 car leur introduction n’as pas donné de résultats satisfaisants.  
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Figure 42 : Représentation des positions des radicaux R3, R4 et R5 dans la structure du composé 

M22. 

Tableau N°9 : Les énergies d’interaction (scores) des 14 composés poly-substitués et leurs BBB 

perméabilité. 

Composé 

poly-substitué 
R3-R4-R5 

Score 

(kcal/mol) 

BBB 

perméabilité 

P1 C=C-O -12.63 Non 

P2 C=N-C -13.92 Non 

P3 C=C-C -14.20 Oui 

P4 C=N-N -13.49 Non 

P5 C=C-N -12.74 Non 

P6 N-C-O -13.18 Non 

P7 N-N=C -13.53 Non 

P8 N-C=C -13.50 Non 

P9 N-N-O -12.88 Non 

P10 N-C=N -12.96 Non 

P11 C-O-C -13.12 Non 

P12 C-O-N -12.18 Non 

P13 N-O-C -12.85 Non 

P14 N-O-N -13.11 Non 
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Parmi les 14 composés du tableau N°9, le composé P3 se révèle comme meilleur inhibiteur de la 

KMO obtenu dans cette étude avec un score de -14.20 kcal/mol. Mieux encore, ce dernier est capable 

de franchir la barrière hémato-encéphalique pour arriver au SNC ou se trouve l’enzyme cible.  

 

Figure 43 : Représentation par Maestro du positionnement du composé P3 dans le site actif de la 

PfKMO. 

 

 

Figure 44 : Diagrammes des interactions entre le ligand P3 et la PfKMO. 

L’analyse visuelle montre que le composé P3 inhibe le site actif de la PfKMO en faisant intervenir 

4 liaisons hydrogène :  
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• La première est établie entre l’oxygène (O) de groupement carboxyle (COOH) de l’inhibiteur et 

la fonction amine secondaire (NH) du résidu ARG84 avec une distance de 1.89 Å. 

• La deuxième est formée, quant à elle, entre la fonction carboxyle (COOH) de l’inhibiteur et 

l’oxygène (O) de groupement hydroxyle (OH) du résidu TRY98 avec une distance de 2.04 Å. 

• Les deux dernières liaisons hydrogène font intervenir le deuxième oxygène (O) de groupement 

carboxyle (COOH) de l’inhibiteur qui se lie avec la fonction amine (NH2) du résidu ASN369, 

ainsi qu’avec celle du résidu ARG84 avec des distances respectives de 1.99 Å et 1.69 Å.  

Treize (13) interactions hydrophobiques interviennent pour stabiliser d’avantage ce complexe P3-

PfKMO incluant les résidus : LEU55, ALA56, TYR98, LEU213, ILE215, ILE224, LEU226, PRO318, 

PHE319, MET324, PHE238, MET373 et TYR404 du site actif de l’enzyme. 

 

Résidus clés dans le site actif de la PfKMO 

La visualisation des interactions des nouveaux inhibiteurs proposés ainsi que ceux existants déjà 

montre que les acides aminés ARG84, TYR98, ASN369 jouent un rôle essentiel dans le site actif de 

la PfKMO car ils établissent des liaisons hydrogènes avec le composé M22 (meilleur composé 

monosubstitué), aussi avec le composé P3 (meilleur composé dans cette étude). L’importance 

également des résidus ALA56, LEU213, ILE215, ILE224, PRO318, PHE319, MET373 et TYR404 

est à souligner car participent à la stabilisation des complexes enzyme-inhibiteur.  

 

4. Les propriétés ADMET 

En plus d'une puissante activité inhibitrice, il est essentiel qu'un bon candidat médicament ait un 

bon profil ADMET. Dans ce contexte et pour compléter notre étude, nous avons évalué certaines 

propriétés physicochimiques en appliquant la règle de Lipinski de 5 et celle de Veber. De plus,  nous 

avons également déterminé certaines propriétés pharmacocinétiques, ainsi que la toxicité potentielle 

de nos meilleurs inhibiteurs. La Donépézil a été utilisée comme molécule de référence.  Ce composé 

est l’un des traitements disponibles de la maladie d'Alzheimer en tant qu'inhibiteur de 

l'acétylcholinestérase [103]. À titre de rappel, il n’existe aucun médicament sur le marché ciblant notre 

enzyme, la Kynurénine 3-monooxygénase.  
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4.1 Propriétés physicochimiques 

Les résultats obtenus à l’aide du serveur SwissADME dans le tableau N°10 révèlent que les 

composés S185, M22, P3 et Donépézil respectent parfaitement les règles de Lipinski et Veber, ce qui 

indique que ces composés peuvent être administrés par voie orale sans poser de problèmes. Cependant, 

nous avons noté une faible solubilité de tous ces composés dans l'eau ce qui rend leurs solubilités dans 

le sang un peu difficile. Ce problème peut être résolu lors de l'optimisation de ces composés. 

Concernant l'accessibilité à la synthèse, ce critère a été évalué par un nombre allant de 1 à 10 où la 

difficulté de synthèse d'un composé est augmentée avec l'augmentation de sa valeur. Les résultats 

obtenus montrent que la synthèse chimique de tous les composés mentionnés dans le tableau semble 

être réalisable expérimentalement avec des valeurs inférieures à 5. 

Tableau N°10 : Propriétés physicochimiques des composés S185, M22, P3 et la Donépézil à partir 

de serveur SwissADME. 

Propriétés Donépézil S185 M22 P3 

Score / -12,06 -13.42 -14.20 

Formule C24H29NO3 C18H18ClN3O4 C22H25ClN4O4 C24H28ClN3O3 

PM (g/mol) 379.49 375.81 444.91 441.95 

n.LF 6 7 8 8 

n.ON 4 7 8 6 

n.OHNH 0 1 1 1 

Log P 4.00 3.09 2.74 3.43 

TPSA Å² 38.77 98.34 101.58 75.55 

Règle de Lipinski 
Parfaitement 

conforme 

Parfaitement 

conforme 

Parfaitement 

conforme 

Parfaitement 

conforme 

Règle de Veber 
Parfaitement 

conforme 

Parfaitement 

conforme 

Parfaitement 

conforme 

Parfaitement 

conforme 

Solubilité dans l’eau Peu soluble Peu soluble Peu soluble Peu soluble 

Accessibilité à la 

synthèse 
3.62 3.82 4.17 4.30 

PM = poids moléculaire. n.ON = nombre d’accepteur d’hydrogène. n.OHNH = nombre de 

donneur d’hydrogène. n.LF = nombre de liaison flexible. LogP = logarithme du coefficient de 

partage eau/octanol. TPSA = surface polaire topologique. 
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4.2 Propriétés pharmacocinétiques 

Une analyse des propriétés pharmacocinétiques a été effectuée en utilisant le serveur SwissADME 

afin d’aller vers le composé ayant le plus de chance d’être un candidat médicament. Les résultats 

obtenus sont illustrés dans le tableau N°11. 

Tableau N°11 : Propriétés pharmacocinétiques des composés S185, M22, P3 et la Donépézil à 

partir de serveur SwissADME. 

Propriétés Donépézil S185 M22 P3 

GI absorption Élevée Élevée Élevée Élevée 

BBB perméabilité Oui Non Non Oui 

CYP1A2 inhibition Non Oui Oui Non 

CYP2C19 inhibition Non Oui Oui Non 

CYP2C9 inhibition Non Oui Non Non 

CYP2D6 inhibition Oui Non Oui Oui 

CYP3A4 inhibition Oui Oui Oui Oui 

GI = Gastro Intestinal. BBB = Blood Brain Barrier. CYP = famille de Cytochrome P450. 

Comme le montre le tableau N°11, la Donépézil, ainsi que les composés S185, M22 et P3, ont 

présenté une absorption gastro-intestinale élevée. Autrement dit, ces composés peuvent traverser la 

barrière gastro-intestinale pour atteindre la circulation sanguine. La Donépézil et le composé P3 

présentent une capacité élevée à franchir la barrière hémato-encéphalique contrairement aux composés 

S185 et M22. Ce critère est très important dans notre cas car la cible se trouve dans le système nerveux 

central. Concernant l'inhibition des différentes isoformes du cytochrome P450, les résultats montrent 

que la Donépézil et le composé P3 ont un effet inhibiteur potentiel envers seulement 2 parmi les 5 

isoformes du cytochrome P450 et pour les deux autres composés (S185 et M22) contrairement aux 

composés S185 et M22 qui inhibent 4 parmi les 5 isoformes de CYP. L'inhibition de ces enzymes est 

une source importante d'interactions médicamenteuses indésirables car des changements dans leurs 

activités enzymatiques peuvent affecter le métabolisme des médicaments. 

4.3 Tests de toxicité 

Le serveur PreADMET a été utilisé pour simuler la toxicité potentielle des composés d’intérêts. Les 

résultats obtenus sont représentés dans le tableau N°12. 
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Il s’avère que tous les composés ainsi que la Donépézil ont un effet mutagène potentiel qui se traduit 

par leur possibilité à induire des changements dans le matériel génétique. Cependant, il a été prédit 

que tous ces composés n'ont aucun effet cancérigène sur les souris ou les rats. Nous avons également 

noté un risque moyen d'inhibition du gène hERG par le composé P3 et la Donépézil, contre un faible 

risque par les composés S185 et M22. L'inhibition de ce gène provoque des problèmes cardiaques 

associés au rythme cardiaque. De plus, les résultats obtenus des tests de toxicité aiguë sur les 

différentes espèces aquatiques étaient prometteurs pour tous les composés, en particulier pour le 

composé P3, qui a obtenu des valeurs nettement inférieures à celles observées pour tous les composés 

y compris la Donépézil ce qui suggère que la toxicité aiguë de ce composé est relativement faible. 

Tableau N°12 : Résultats des tests in silico de toxicité des composés S185, M22, P3 et la Donépézil 

à partir de serveur PreADMET. 

Paramètre Donépézil S185 M22 P3 

Test d’Ames mutagène mutagène mutagène mutagène 

Cancérogénicité 

pour les souris 
négative négative négative négative 

Cancérogénicité 

pour les rats 
négative négative négative négative 

hERG inhibition Risque médium Risque faible Risque faible Risque médium 

Algae-at 0.0104476 0.0159016 0.0100469 0.00602444 

Daphnia-at 0.0239157 0.0365653 0.019723 0.0101264 

Medaka-at 0.0011081 0.00283516 0.000947906 0.000247143 

Minnow-at 0.00212956 0.00201793 0.00143914 0.00064731 

 

En conclusion, le composé P3 a présenté un profil ADMET favorable pour une application 

biologique ce qui ouvre la voie à son optimisation et développement, en tant que candidat médicament. 
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Conclusion et perspectives 

L’objectif principal de notre travail était de contribuer au développement in silico de nouveaux 

inhibiteurs par docking moléculaire avec AutoDock de la cible thérapeutique Kynurénine 3-

monooxygenase.  

Tout d’abord, nous avons jugé utile d’évaluer la fiabilité du programme AutoDock par le biai de 

trois tests différents. Le premier test consiste à calculer l’écart quadratique moyen ou le RMSD qui 

permet d’évaluer la déviation de la pose du ligand simulée par AutoDock vis-à-vis de celle déterminée 

expérimentalement. Parmi les 100 complexes protéines-ligands tirés arbitrairement de la PDB, 82 

complexes ont présenté de faibles valeurs de RMSD parfaitement dans les normes, c’est-à-dire, 

inférieur à 2 Å. Une analyse visuelle a été réalisée sur quatre complexes issus de la PDB portant les 

codes suivants : 5NAB, 6FP1, 5NAE et 6FPH a montré que le modèle des ligands simulé par 

AutoDock se superpose avec celui Co-cristallisé. Un dernier test a permet d’évaluer le degré de 

corrélation existant entre les énergies d’interaction (ΔG) des 107 inhibiteurs de la KMO (issus de la 

littérature) simulés avec AutoDock et les valeurs expérimentales de leurs IC50. Avec un coefficient de 

corrélation égal à 0.70, le programme AutoDock est suffisamment fiable et peut être utilisé sans grands 

risque d’erreurs, pour simuler les interactions des complexes PfKMO-Inhibiteur étudiés. 

Parmi les 107 inhibiteurs de la KMO étudiés, le composé C45 a été prédit d’avoir la meilleur activité 

inhibitrice à l’égard de la KMO avec une énergie d’interaction de -10.87 kcal/mol. Cependant, ce 

composé a été prédit d’être incapable à franchir la barrière hémato-encéphalique. Afin d’améliorer 

aussi bien son affinité envers la cible que ses propriétés ADMET, nous avons réalisé un criblage 

virtuel d’une collection de similaires chimiques du composé C45 issus de la PubChem. Ce criblage 

fait ressortir le composé S185 comme meilleur inhibiteur de la PfKMO (énergie d’interaction = -12.06 

kcal/mol) parmi les 352 composés criblés. À l’instar du composé C45, le composé S185 est incapable 

de franchir la barrière hémato-encéphalique.  

Par la suite, une série de substitutions structurales a été menée sur le composé S185 en vue 

d’améliorer davantage aussi bien son affinité à l’égard de la cible que ses propriétés ADMET. Parmi 

les 62 composés testés, le composé P3 se présente comme nouvel inhibiteur de la KMO avec une 

énergie d’interaction de -14.20 kcal/mol. Mieux encore, l’étude prédictive de ses propriétés 

physicochimiques, pharmacocinétiques et de toxicité potentielle nous renseigne de manière positive 

sur le profil ADMET du composé P3 particulièrement sa bonne capacité à franchir la barrière hémato-

encéphalique pour atteindre son lieu d’action.  
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En termes de perspectives d’avenir et afin d’approfondir notre recherche, une étude expérimentale 

complémentaire in vitro et/ou in vivo est nécessaire pour vérifier et confirmer les résultats théoriques 

obtenus in silico au cours de notre travail. 
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Annexe N°1 : Les valeurs de RMSD de 100 complexes étudiés. 

N° Code PDB Code des ligands RMSD (A°) 

1 1DOJ 1Z0 2.18 

2 1GYM MYG 1.83 

3 1H3C R79 1.22 

4 1YDT IQB 1.00 

5 1Z89 62P 0.51 

6 2F6T 1C2 0.58 

7 2H5A X1P 0.63 

8 2Q8I RDC 0.47 

9 2RJP 886 0.85 

10 2V5Z SAG 1.83 

11 2V60 C17 1.07 

12 2V61 C18 1.14 

13 3BJC WAN 2.68 

14 3CTT 3CU 0.68 

15 3DBS GD9 0.65 

16 3E9K 3XH 1.88 

17 3ENE NPZ 0.69 

18 3G5E Q74 0.25 

19 3HVG EV0 0.52 

21 3I1Y 33N 0.72 

22 3K5G BJC 1.48 

23 3KOO 24D 0.93 

24 3L54 LXX 0.46 

25 3MJW WYF 0.49 

26 3MSJ EV3 5.21 

27 3PI5 3P5 0.69 

28 3PIY 585 0.83 

29 3SN7 540 0.47 

30 3SNI 546 0.81 

31 3VEU 0GO 1.55 

32 3VF3 0GS 0.80 

33 3VV6 B00 2.06 
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34 3WB4 0B3 2.33 

35 3WB5 0B4 2.34 

36 3WI2 P98 0.72 

37 3WS8 X4C 0.66 

38 4ACC 7YG 1.09 

39 4ACD GR9 1.01 

40 4ACG 6LQ 0.93 

41 4ACH KDI 1.12 

42 4B0O 15F 1.23 

43 4BC5 5FX 1.08 

44 4BDS THA 0.65 

45 4EY7 E20 0.61 

46 4GDY 0X1 1.82 

47 4GE4 0KE 1.31 

48 4GE7 0K5 1.71 

49 4GE9 0L0 2.47 

50 4GEB 0LD 2.41 

51 4GID 0GH 1.66 

52 4J36 1HR 0.56 

53 4JP9 1M5 0.49 

54 4KZ0 1UJ 0.78 

55 4LXA 1YS 1.28 

56 4QEM HC4 1.48 

57 4QER STL 1.56 

58 4QF7 C0R 1.16 

59 4QF8 SPD 1.88 

60 4QGD PZZ 2.68 

61 4RFZ 3OV 0.66 

62 4URK A82 0.78 

63 4Y2H 49K 0.62 

64 4ZPG 4QF 0.61 

65 5AXP 4LK 0.71 

66 5CLM 52K 0.55 

67 5E80 5KP 0.89 

68 5FN0 JHY 0.48 
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69 5I3Y 68K 3.01 

70 5IKQ JMS 0.41 

71 5N7T JHY 0.40 

72 5NAB 8RK 0.27 

73 5NAE 8R8 0.49 

74 5NAG 8R5 0.64 

75 5NAH 8RB 0.85 

76 5P2P DHG 2.69 

77 5UWF 8Q7 0.55 

78 5WQK 7NC 0.49 

79 6AUW W80 3.75 

80 6B3T CJ7 2.56 

81 6DI5 GJ7 0.56 

82 6DI9 GJJ 2.16 

83 6EP4 DME 1.30 

84 6EN5 BJ2 0.88 

85 6EQQ H19 4.89 

86 6ESJ PRM 4.45 

87 6EVR BZW 0.80 

88 6FOY E0T 1.67 

89 6FOZ E0H 1.61 

90 6FP0 E0N 0.56 

91 6FP1 E0Q 0.30 

92 6FPH E1W 0.45 

93 6H0U FKB 0.96 

94 6NV7 L3J 0.78 

95 6NW3 L4J 0.75 

96 6QAB HUQ 1.80 

97 6QAC HUT 1.61 

98 6QAD HUZ 2.35 

99 6QAE HUK 3.22 

100 6S90 L0Z 1.14 
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Annexe N°2 : Les structure des 107 inhibiteurs utilisés dans le test de corrélation linéaire . 
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Annexe N°3 : Les numéros d’accession et les scores des 352 composés similaires. 

Composé Numéro d’accession CID ΔG (kcal/mol) 

S1 CID_3282927 -6.30 

S2 CID_3338828 -8.33 

S3 CID_3636031 -7.48 

S4 CID_3844768 -8.46 

S5 CID_4262354 -6.98 

S6 CID_4266611 -8.96 

S7 CID_4303704 -7.29 

S8 CID_10202432 -7.69 

S9 CID_10208599 -6.90 

S10 CID_10310005 -8.90 

S11 CID_11591324 -8.90 

S12 CID_11619338 -8.59 

S13 CID_11698895 -10.13 

S14 CID_11847058 -8.36 

S15 CID_12024409 -8.45 

S16 CID_12352186 -7.44 

S17 CID_13015692 -7.27 

S18 CID_13015695 -8.58 

S19 CID_13015696 -9.12 

S20 CID_13977073 -7.96 

S21 CID_15084649 -7.36 

S22 CID_15084685 -8.55 

S23 CID_18675770 -8.96 

S24 CID_19701552 -7.30 

S25 CID_21985930 -7.78 

S26 CID_21985932 -7.77 

S27 CID_23368499 -7.29 

S28 CID_23444815 -7.97 

S29 CID_23549380 -8.53 

S30 CID_24589989 -9.28 

S31 CID_24748253 -10.76 

S32 CID_24958862 -8.25 
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S33 CID_24962443 -10.68 

S34 CID_25002758 -9.59 

S35 CID_25003109 -9.75 

S36 CID_29139466 -9.57 

S37 CID_29140033 -9.11 

S38 CID_30284828 -9.49 

S39 CID_30284858 -9.04 

S40 CID_30582418 -9.05 

S41 CID_33993521 -7.95 

S42 CID_39332786 -9.19 

S43 CID_39339593 -9.39 

S44 CID_39340672 -8.84 

S45 CID_39342452 -9.59 

S46 CID_39352114 -9.54 

S47 CID_39352491 -9.26 

S48 CID_42225073 -9.95 

S49 CID_42225074 -9.43 

S50 CID_42225075 -9.87 

S51 CID_42225076 -9.94 

S52 CID_42225077 -9.51 

S53 CID_42225078 -9.88 

S54 CID_42225079 -9.57 

S55 CID_42630415 -9.79 

S56 CID_44248243 -8.69 

S57 CID_44337866 -7.43 

S58 CID_44428917 -7.94 

S59 CID_44428918 -8.64 

S60 CID_44428919 -8.14 

S61 CID_44428920 -8.49 

S62 CID_45513049 -8.62 

S63 CID_45513205 -8.22 

S64 CID_45513454 -8.44 

S65 CID_47081888 -9.46 

S66 CID_51897037 -9.59 

S67 CID_51897038 -9.05 
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S68 CID_55312171 -9.82 

S69 CID_56292915 -9.38 

S70 CID_56507988 -9.93 

S71 CID_56528327 -10.36 

S72 CID_56710576 -8.24 

S73 CID_58018395 -7.17 

S74 CID_58018433 -9.07 

S75 CID_58018494 -9.20 

S76 CID_58018536 -8.08 

S77 CID_58018607 -9.31 

S78 CID_58018828 -7.79 

S79 CID_58018875 -7.88 

S80 CID_58018939 -7.85 

S81 CID_58018947 -5.76 

S82 CID_58019007 -10.24 

S83 CID_58688772 -7.67 

S84 CID_58688815 -8.33 

S85 CID_58688829 -10.58 

S86 CID_59520432 -9.38 

S87 CID_59674962 -9.79 

S88 CID_59675025 -10.23 

S89 CID_66644413 -8.78 

S90 CID_66758585 -7.64 

S91 CID_66778973 -6.86 

S92 CID_67297286 -10.48 

S93 CID_68442825 -10.50 

S94 CID_68443422 -9.27 

S95 CID_68444859 -10.32 

S96 CID_68694432 -10.74 

S97 CID_68877979 -7.53 

S98 CID_68917681 -10.68 

S99 CID_68917685 -9.81 

S100 CID_68920339 -5.46 

S101 CID_68920346 -9.33 

S102 CID_68920380 -9.48 
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S103 CID_68920393 -10.36 

S104 CID_68920526 -10.41 

S105 CID_68920979 -7.68 

S106 CID_68922988 -11.13 

S107 CID_68922992 -11.16 

S108 CID_68923201 -9.67 

S109 CID_68923208 -10.26 

S110 CID_68923354 -5.58 

S111 CID_70885093 -9.98 

S112 CID_72026238 -9.26 

S113 CID_85946597 -8.26 

S114 CID_86268764 -9.29 

S115 CID_87138046 -11.03 

S116 CID_87138047 -7.88 

S117 CID_89179858 -10.86 

S118 CID_89343832 -8.23 

S119 CID_89766964 -10.05 

S120 CID_89766988 -9.22 

S121 CID_90426797 -8.67 

S122 CID_90808261 -5.10 

S123 CID_91133706 -7.31 

S124 CID_91535871 -6.93 

S125 CID_91687270 -8.01 

S126 CID_92405430 -8.54 

S127 CID_92405431 -9.34 

S128 CID_92405432 -9.36 

S129 CID_93735084 -10.58 

S130 CID_93735108 -11.31 

S131 CID_93735126 -10.34 

S132 CID_93735178 -9.89 

S133 CID_93735188 -10.06 

S134 CID_93735213 -9.23 

S135 CID_93735231 -9.34 

S136 CID_95217108 -8.14 

S137 CID_95217109 -8.21 
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S138 CID_97435369 -9.71 

S139 CID_101235361 -8.56 

S140 CID_101346008 -5.94 

S141 CID_104629631 -8.73 

S142 CID_106535488 -6.42 

S143 CID_106535840 -8.04 

S144 CID_115110767 -9.11 

S145 CID_115113759 -9.59 

S146 CID_118254085 -7.92 

S147 CID_118491960 -10.36 

S148 CID_118492118 -10.60 

S149 CID_118536059 -9.69 

S150 CID_121415026 -10.80 

S151 CID_121415029 -9.67 

S152 CID_121415031 -11.07 

S153 CID_121415033 -9.81 

S154 CID_121415035 -7.89 

S155 CID_121415036 -10.87 

S156 CID_121415041 -10.90 

S157 CID_121415044 -9.35 

S158 CID_121415048 -11.94 

S159 CID_121415049 -11.54 

S160 CID_121415050 -11.14 

S161 CID_121415051 -9.50 

S162 CID_121415052 -11.67 

S163 CID_121415057 -11.60 

S164 CID_121415058 -9.95 

S165 CID_121415059 -11.26 

S166 CID_121415060 -10.83 

S167 CID_121415063 -11.37 

S168 CID_121415065 -10.76 

S169 CID_121415066 -10.86 

S170 CID_121415067 -9.77 

S171 CID_121415068 -9.97 

S172 CID_121415069 -10.61 
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S173 CID_121415071 -9.70 

S174 CID_121415073 -11.04 

S175 CID_121415074 -11.23 

S176 CID_121415076 -10.14 

S177 CID_121415077 -10.12 

S178 CID_121415078 -9.26 

S179 CID_121415079 -11.41 

S180 CID_121415080 -11.08 

S181 CID_121415081 -10.61 

S182 CID_121415083 -11.66 

S183 CID_121415084 -9.70 

S184 CID_121415086 -10.79 

S185 CID_121415087 -12.06 

S186 CID_121415088 -10.62 

S187 CID_121415092 -11.14 

S188 CID_121415093 -8.62 

S189 CID_121415094 -10.53 

S190 CID_121415097 -11.22 

S191 CID_121415099 -10.81 

S192 CID_121415107 -9.70 

S193 CID_121415109 -10.79 

S194 CID_121415115 -11.16 

S195 CID_121415116 -11.13 

S196 CID_121415117 -11.29 

S197 CID_121415118 -11.00 

S198 CID_121415121 -9.92 

S199 CID_121415122 -11.37 

S200 CID_121415123 -10.80 

S201 CID_121415127 -10.01   

S202 CID_121415129 -10.59 

S203 CID_121415130 -11.62 

S204 CID_121415131 -10.89   

S205 CID_121415134 -10.89 

S206 CID_121415137 -9.53 

S207 CID_121415138 -8.23 
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S208 CID_121415140 -9.74 

S209 CID_121415142 -10.38 

S210 CID_121415143 -9.88 

S211 CID_121415144 -10.36 

S212 CID_121415145 -8.50 

S213 CID_121415146 -11.59 

S214 CID_121415147 -9.45 

S215 CID_121415148 -10.28 

S216 CID_121415162 -11.00 

S217 CID_121415168 -11.16 

S218 CID_121415171 -9.75 

S219 CID_121415172 -11.64 

S220 CID_121415177 -10.93 

S221 CID_121415179 -10.95 

S222 CID_121415180 -11.03 

S223 CID_121415183 -10.52 

S224 CID_121415185 -9.67 

S225 CID_121415187 -9.47 

S226 CID_121415188 -9.76 

S227 CID_121415191 -11.00 

S228 CID_121415195 -10.32 

S229 CID_121415196 -11.19 

S230 CID_121415199 -9.76 

S231 CID_121415202 -9.63 

S232 CID_121415203 -10.94 

S233 CID_121415204 -10.73   

S234 CID_121415206 -9.86 

S235 CID_121415208 -8.86 

S236 CID_121415209 -10.57 

S237 CID_121415212 -9.97 

S238 CID_121427681 -10.50 

S239 CID_121427698 -11.55 

S240 CID_121427740 -10.44 

S241 CID_125430097 -3.78 

S242 CID_125430098 -4.78 
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S243 CID_129895497 -3.42 

S244 CID_131899336 -7.96 

S245 CID_132188634 -7.36 

S246 CID_132188635 -8.73 

S247 CID_132188638 -7.10 

S248 CID_132188639 -8.83 

S249 CID_132188642 -8.17 

S250 CID_132188644 -8.48 

S251 CID_132188645 -9.02 

S252 CID_132188647   -6.71 

S253 CID_132188648 -7.93 

S254 CID_132188650 -8.65 

S255 CID_132188652 -8.92 

S256 CID_132188669 -6.11 

S257 CID_132188670 -8.19 

S258 CID_132188679 -6.17 

S259 CID_132188680 -6.25 

S260 CID_132188692 -6.50 

S261 CID_132207506 -7.90 

S262 CID_132207507 -8.03 

S263 CID_132207511 -6.57 

S264 CID_132207660 -10.39 

S265 CID_132207844 -6.53 

S266 CID_132207845 -9.76 

S267 CID_132207871 -9.46 

S268 CID_132286033 -2.33 

S269 CID_135133635 -10.08 

S270 CID_135133757 -11.10 

S271 CID_135138962 -10.29 

S272 CID_135138965 -7.55 

S273 CID_135138973 -9.83 

S274 CID_135139150 -10.42 

S275 CID_135139686 -8.47 

S276 CID_135139688 -11.33 

S277 CID_135140553 -10.33 
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S278 CID_135244237 -8.42 

S279 CID_135589642 -7.17 

S280 CID_135894508 -9.86 

S281 CID_136087040 -7.62 

S282 CID_136203485 -9.23 

S283 CID_136401499 -7.97 

S284 CID_136401517 -7.64 

S285 CID_136401572 -7.54 

S286 CID_136401583 -9.50 

S287 CID_136401586 -7.67 

S288 CID_136477397 -7.48 

S289 CID_136500455 -9.12 

S290 CID_136500489 -9.02 

S291 CID_136500640 -8.52 

S292 CID_136500645 -9.17 

S293 CID_136500657 -9.37 

S294 CID_136500680 -9.40 

S295 CID_136500690 -7.36 

S296 CID_136887029 -9.84 

S297 CID_136887077 -7.63 

S298 CID_137179739 -7.68 

S299 CID_137374825 -10.53 

S300 CID_137374848 -10.68 

S301 CID_138602511 -9.04 

S302 CID_138602513 -4.68 

S303 CID_138642903 -10.96 

S304 CID_138642905 -11.35 

S305 CID_138642970 -8.88 

S306 CID_139221440 -10.00 

S307 CID_139221443 -8.73 

S308 CID_140346224 -6.96 

S309 CID_140472755 -7.26 

S310 CID_140821199 -7.74 

S311 CID_140821200 -7.45 

S312 CID_140821201 -7.47 



 

                                                                                                                                       75 |   
 

  A N N E X E S  

 
S313 CID_140821202 -8.97 

S314 CID_140821203 -8.78 

S315 CID_140821204 -8.71 

S316 CID_140821205 -7.53 

S317 CID_140821206 -8.53 

S318 CID_140821207 -8.22 

S319 CID_140821208 -8.50 

S320 CID_140821209 -9.71 

S321 CID_140821210 -7.51 

S322 CID_140821211 -8.37 

S323 CID_140821212 -8.89 

S324 CID_140821213 -9.36 

S325 CID_141566495 -10.10 

S326 CID_141701213 -8.46 

S327 CID_141701214 -8.97 

S328 CID_141701215 -8.77 

S329 CID_141701216 -6.96 

S330 CID_141701217 -7.53 

S331 CID_142512508 -9.74 

S332 CID_142735005 -4.90 

S333 CID_142768727 -9.30 

S334 CID_142799028 -8.74 

S335 CID_142799029 -8.94 

S336 CID_142799033 -8.74 

S337 CID_142799034 -8.03 

S338 CID_142799035 -8.57 

S339 CID_142799036 -9.54 

S340 CID_142799037 -10.19 

S341 CID_142799039 -8.06 

S342 CID_142799042 -8.31 

S343 CID_142799044 -9.04 

S344 CID_142799046 -10.46 

S345 CID_143570542 -9.49 

S346 CID_143570558 -9.97 

S347 CID_143570629 -11.26 



 

                                                                                                                                       76 |   
 

  A N N E X E S  

 
S348 CID_145102679 -10.03 

S349 CID_145192968 -9.66 

S350 CID_145362637 -1.44 

S351 CID_145805447 -8.05 

S352 CID_145805448 -8.09 

 

 



 

 

 

 

 

 

 

 

 

RÉSUMÉ 



 

                                                                                                                                       56 |   
 

  R É S U M É  

 

Conception in silico de nouveaux inhibiteurs de la Kynurénine 3-

monooxygenase par docking moléculaire 

Résumé  

Le docking moléculaire est une des approches de modélisation moléculaire permettant la simulation 

des interactions protéine-ligand. Cette approche a été employée dans le présent travail en vue de 

proposer de nouveaux inhibiteurs de la KMO ; enzyme cible thérapeutique prouvé utile dans le 

traitement de la maladie de Huntington, la maladie d'Alzheimer, la maladie de Parkinson, ainsi que 

d’autres maladies comme : la pancréatite aiguë. Le criblage virtuel d’une collection de similaires 

chimiques du composé C45, suivie par une série de substitutions structurales fait ressortir le composé 

P3 comme meilleur inhibiteur de la KMO avec une énergie d’interaction égale à -14.20 kcal/mol, 

nettement inférieure à celle du composé de départ soit -10.87 kcal/mol. Enfin, l’étude prédictive des 

propriétés physicochimiques, pharmacocinétiques et de toxicité potentielle nous renseigne de manière 

positive sur le profil ADMET du composé P3 particulièrement sa bonne capacité à franchir la barrière 

hémato-encéphalique pour atteindre son lieu d’action.  

 

Mot clés : AutoDock, barrière hémato-encéphalique, docking moléculaire, inhibiteur, Kynurénine 3-

monooxygenase. 
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  A B S T R A C T  

 

In silico design of new inhibitors of Kynurenine 3-monooxygenase by 

molecular docking 

Abstract   

Molecular docking is one of the molecular modeling approaches allowing the simulation of protein-

ligand interactions. This approach was employed in the present work with a view to proposing new 

inhibitors of KMO ; a therapeutic target enzyme proven useful in the treatment of Huntington's 

disease, Alzheimer's disease, Parkinson's disease, as well as other diseases such as: acute pancreatitis. 

Virtual screening of a collection of chemical analogues of compound C45, followed by a series of 

structural substitutions reveals compound P3 as the best KMO inhibitor with an interaction energy of 

-14.20 kcal/mol, significantly lower than that of the starting compound that is -10.87 kcal/mol. Finally, 

the predictive study of the physicochemical, pharmacokinetic properties and potential toxicity 

provides us with positive information on the ADMET profile of compound P3, particularly its good 

ability to cross the blood-brain barrier to reach its site of action. 

 

Keywords : AutoDock, blood-brain barrier, molecular docking, inhibitor, Kynurenine 3-

monooxygenase. 
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خص    ل م ل  ا

 

الالتحام    عن طريق   Kynurenine 3-monooxygenaseال   نزيم تصميم مثبطات نظرية جديدة ل 

   الجزيئي 

 الملخص 

في عملنا هذا، طبق هذا  . الربيطةالالتحام الجزيئي هو أحد أساليب النمذجة الجزيئية التي تسمح بمحاكاة التفاعلات بين البروتين و 

في علاج داء هنتنغتون، مرض الزهايمر، ومرض ؛ باعتبارها إنزيم مستهدف ثبت فائدته   KMO بهدف اقتراح مثبطات جديدة لـالنهج  

،  C45باركنسون، بالإضافة إلى أمراض أخرى مثل: التهاب البنكرياس الحاد. كشف فحص مجموعة من النظائر الكيميائية للمركب

، أقل بكثير  kcal/mol 14.20-مع طاقة تفاعل تبلغ  KMOلل هو أفضل مثبط P3 متبوعًا بسلسلة من البدائل الهيكلية، أن المركب

تفاعل  من   التي تساويطاقة  البداية  الفيزيوكيميائية،  kcal/mol 10.87-مركب  للخصائص  التنبؤية  الدراسة  لنا  أخيرًا، اظهرت   .

دة على عبور الحاجز ، لا سيما قدرته الجيP3للمركب    ADMETال   الحركية الدوائية والسمية المحتملة معلومات إيجابية عن ملف

 .الدموي الدماغي للوصول إلى موقع عمله

 

 .مثبط ،Kynurénine 3-monooxygenaseحاجز دموي دماغي،  ، الالتحام الجزيئي،AutoDock الكلمات المفتاحية :
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Résumé 

Le docking moléculaire est une des approches de modélisation moléculaire permettant la 

simulation des interactions protéine-ligand. Cette approche a été employée dans le présent travail 

en vue de proposer de nouveaux inhibiteurs de la KMO ; enzyme cible thérapeutique prouvé utile 

dans le traitement de la maladie de Huntington, la maladie d'Alzheimer, la maladie de Parkinson, 

ainsi que d’autres maladies comme : la pancréatite aiguë. Le criblage virtuel d’une collection de 

similaires chimiques du composé C45, suivie par une série de substitutions structurales fait ressortir 

le composé P3 comme meilleur inhibiteur de la KMO avec une énergie d’interaction égale à -14.20 

kcal/mol, nettement inférieure à celle du composé de départ soit -10.87 kcal/mol. Enfin, l’étude 

prédictive des propriétés physicochimiques, pharmacocinétiques et de toxicité potentielle nous 

renseigne de manière positive sur le profil ADMET du composé P3 particulièrement sa bonne 

capacité à franchir la barrière hémato-encéphalique pour atteindre son lieu d’action. 
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